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Introduction

About This Guide
The STEP Flatplanner User Guide contains information about STEP Flatplanner.

The guide assumes the following.

« Thatusers have a working knowledge of STEP Information Server
« That users have a working knowledge of InDesign.
« That publications have already been created in STEP Information Server.

« That product templates and a publication template have been created in InDesign and assigned to the
STEP Information Server database.

The guide only contains information about the STEP Flatplanner. For more information about STEP Information
Server and publication creation, see the STEP User Guide and the Online Help.

For more information about DTP integration, see the STEP Publisher User Guide.

About STEP Flatplanner

STEP Flatplanner helps you make more educated product choices and produce 'Intelligent Catalogs' that will
improve your company’s sales. The visual page briefing tools replace 'lick and sticker' paper briefing.

Flatplanner includes tools that enable advanced collaboration, automation, and analysis, and make your product
selection easier and more efficient.

In addition, Flatplanner provides a single interface for business users to plan, review, and analyze publications.
Creative users can access the publication plan through STEP’n’design for InDesign. Merchandisers can review
and approve artwork at any time through STEP Flatplanner.

Note: Supported versions of Adobe InDesign are CS6, CC 2015 (CC11), and CC 2015.4 (CC11.4.0, June 2016
release).

Flatplanner License Requirements

To be able to use the Flatplanner component, the following components are required in addition to the STEP
Information Server:

o STEP Publisher component

o STEP Flatplanner component

Other licenses may be required for specific features.

Overview of the Flatplanner User Interface

The Flatplanner consists of two main tabs: the Plan tab and the Publication Planner tab.

© Stibo Systems - Confidential 6
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Plan Tab

The Plan tab is available when a publication, section, or spread is selected in the Tree.
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Publication hierarchy. Your starting point.

2. Basket and Flatplanner view. If you have selected your planned pages, you can choose between Basket and
Plan view and Plan view only. Here the Basket and Plan view is shown.

3. Plan tab. If you have selected a publication, section, or spread, you can select Plan view.

4a. Spreads displayed under Section are Planned Pages.

4b. Flatplanner. The Flatplanner is a visual-oriented page planning tool. When you drag a product from the
basket or Tree and drop it on a Flatplan in an area identified for products, it will be placed / added to the products in
that frame.

5b. Basket. In your Basket you can see your products and a thumbnail of each of your products.

5c. Financial Summary. You can also view data on the Financial Summary tab.

Publication Planner Tab
The Publication Planner tab is available when a publication or section is selected.
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1. Publication Planner. The Publication Planner is a monitoring tool. Clicking the Publication Planner tab
instead of the Plan tab gives you a different view on the same Publication. You can see the name and page
numbers of the pages in the Section and the status of each page or Spread.

2. Thumbnail. When a page has been finalized in InDesign and saved back to STEP, a thumbnail of the page is
shown.

3. Status. You can follow the lifecycle of the page in the status column.

Assignee. The Assignee field displays a list of stakeholders that you can assign to the page.

Element Status

Publication Group | & Publication group folder

Publication Publication folder

& Commercial data folder (automatically generated when creating a publication)

£ Commercial list
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Element Icon Status
= Types of commercial lists that are not price
Section & Section folder
(721 | Planned Pages (a Spread)
DTP Documents ( including finalized pages that have been saved back to STEP)
B Finalized DTP page the has been saved back to STEP
Spread (37 | A Spread
Basket it Thumb Pin, locked position
—a Thumb Pin, unlocked position

Flatplanner Components
STEP Flatplanner consists of the following components:

o Publication Planner

« Flatplanner

Publication Planner

The Publication Planner allows you to plan the rough layout of a catalog in sections and spreads or individual
pages, and assign page templates that decide the overall layout.

You can assign owners to individual spreads or pages.

Flatplanner

The Flatplanner is a page planning and briefing tool that allows you to plan the position, size and layout of products
on pages. The Flatplanner consists of a basket area and a spread or page planning area.

Yous can pick product offers from a collection or from the tree and add them to the basket for a section or a spread.

Basket View

The basket provides decision support by displaying product attribute information. Filtering and sorting features
help you select the right products to be placed in a particular position on the page.

© Stibo Systems - Confidential 9



StiboSystems

Collections are sometimes used to gather products that should be linked into a basket. Each publication can
include products from several collections.

Collection examples:

Collection Criteria

Acme Pens Spring Catalog | Include Products with Attribute “Brand Name” = “Acme”

Exclude uploaded file with Product IDs

Zeta Pens Spring Catalog | Include uploaded file with Product IDs

For more information about working with Collections, see the Collections and Collection Groups Overview
topic within the Getting Started documentation.

Sticker Book View
Turn on sticker book view in the Flatplanner to show additional data about the product.

Use the sticker book view to further inspect if the right products have been selected and if they have been placed in
the right location on the page and allocated enough space.

Turn on page preview to view the product in a layout that corresponds to the selected product template. You can
also view it in a layout picked up from another catalog.

When the planned spread or page is completed, it can be forwarded to a DTP Designer who can adjust the layout
in InDesign.

The result of this can be saved back to STEP, and the mounted page can be viewed in the Flatplanner.

Publication Related Elements
The following is a list of the publication related elements in the STEP Flatplanner.

Publication Group
A publication group is a collection of different publications.

Publication

A publication is a collection of the different sections and commercial data lists. For more information about creating
a publication, see the Overview of Publication Maintenance section of the Getting Started / STEP User
Guide documentation.

Version

A publication version holds the different variants of the same publication. A publication can have a number of
different versions that each point to a commercial list, a context and a workspace.

© Stibo Systems - Confidential 10
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This is useful, for example, if a publication is released in several languages. Then it is possible to create a version
for each language.

Section
A section is an object that is used to store actual (mounted) pages within the publication

Spread
A spread consists of two adjacent, facing pages in a publication with conjoined or connected content.

Basket

A basket is a container for temporarily storing and displaying products, classifications, and assets before they are
used on a planned page. Products, classifications, and assets can be retrieved from the STEP database or
collection lists and dragged into baskets that are tied to the publication, section, or an individual spread.
Alternately, objects can be imported into the basket by the import of a Flatplan Excel, Publication Excel,
STEPXML, or even a plain .txt file or .csv file.

For more information about collection lists, see the Collections and Collection Groups Overview section of the
Getting Started / STEP User Guide documentation.

Using Templates With Flatplanner

To plan and design a catalog in STEP Flatplanner, you will use a publication template, page templates, and
product templates.

You can design page templates directly in STEP. However, before you start using Flatplanner, the publication
template and product template(s) must be created in InDesign and stored in STEP. For more information, see the
STEP'n'design User Guide.

The following is a brief description of the different types of templates.

Page Templates

A page template allows you to define the layout of a page such as defining where you are allowed to place a
product and the related product template. For more information, see Creating Page Templates in the
Flatplanner documentation.

Product Templates

A product template enables you to mount fully formatted product presentations directly to the page. The product
template controls the following:

« Which attributes are part of the product presentation

« The formatting of the product presentation such as fonts, styles, and so on

o The position of the individual elements

© Stibo Systems - Confidential 11
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Publication Templates

A publication template defines the document size and margins and contains information about static elements
such as page tabs. It also contains definitions of all paragraph and character styles to be used from the product
templates.

A publication template is used to create the PDF files of your pages, to create a preview of your pages, and it is
also used when mounting the pages in InDesign.

For more information about creating product templates and publication templates, see the following sections of the
STEP'n'design documentation:
« Publication Templates

o Product Templates

Creating Page Templates

The Create Page Template wizard helps you create a page template with the measures you prefer.
« Tostartthe Create Page Template Wizard, right-click a Publication Group, and then select New Page
Template. The Create Page Template wizard appears.

The wizard walks you through four steps.

The Create Template Wizard
Step 1 - Set Page Template

On the first screen of the Create Template wizard, you specify the name of the template. Enter the ID and Name of
the new page template, and then click Next.

© Stibo Systems - Confidential 12
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-
Create Page Template —— u
E 3
Steps Set Page Template Name
1. Set Page Template Name
2. Choose Publication Template to base on
3. Select Spread

4, Confirm Page Dimensions

ID: |NewTemplate| |

Mame: |NewTemplate |

| Back |[ Mext ]| Finish |[ Cancel

Step 2 - Choose Publication Template

In the next step, you choose the publication template that you want to base the page template on. Expand the
Publication hierarchy to locate the preferred template. Alternatively, use search to find the preferred template.
Click Next.

© Stibo Systems - Confidential 13
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[F——1
ﬁfmate Page Template _ -

Steps Choose Publication Template to base on

1. Set Page Template Name Browse | search

2. Choose Publication Template to base on
3. select Spread - [§) Publications
4, Confirm Page Dimensions

Step 3 - Select Spread

On this screen, you select the relevant spread in the publication template, from which you want to inherit the page
size and margins. A thumbnail of each available spreads is displayed. Click Next.

© Stibo Systems - Confidential 14
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-
Create Page Template —— u
E 3
Steps Select Spread
1. Set Page Template Mame Spread number = |Thumbnail Page ™ | Thumbnail Page -
2. Choose Publication Template to base on
3. Select Spread
4, Confirm Page Dimensions
1
— e
i
2
i
!
[ Back H Mext ][ Finish ][ Cancel

AE—

Step 4 - Confirm Page Dimensions

The final step of the Create Template wizard provides an overview of the page size and margins of the new page
template. You can change any of the measures.

Click Finish to create the new page template. The new page template is placed in the Tree below the publication
group you initially selected.

© Stibo Systems - Confidential 15
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r Create Page Template — u1
Steps Confirm Page Dimensions
1. Set Page Template Mame Name | value -
2. Choose Publication Template to base on |54, 8.27 inches
3. Select Spread - Height 11.69 inches
4. Confirm Page Dimensions Left Inside Margin 0.98 inches
Left Outside Margin 0,98 inches
Left Top Margin 0,52 inches
Left Bottom Margin 0.67 inches
Right Inside Margin 0,98 inches
Right Qutside Margin 0,98 inches
Right Top Margin 0.58 inches
Right Bottom Margin 0.67 inches

Mext | | Finish |[ Cancel ]

Note: You can change the margins of the page template later, but you cannot change the page size of the page
template once the page template has been created.

Designing Frames for Page Templates

Frames are used to place product presentations and images in Flatplanner. You use the Designer tool bar on the
Designer tab to add and position frames on the page template.

Designer Tool Bar

« Toaccess the Designer tool bar, click a page template in the Tree, and then click the Designer tab.

Description

F=H Used to save all changes

© Stibo Systems - Confidential 16
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Tool Description

Y Used to select and move frames and content on the page by dragging them.
Select
[ Used to add new frames by clicking and dragging the mouse.
Add frame
[ Used to delete a frame. Delete is only enabled when one or more frames are selected.
Delete
T Used to insert multiple frames in a grid on the page.
Insert frames on
agrid
3 Used to undo your last action.
Undo
= Used to redo your last action.
Redo
o Used to enable or disable snapping of frames when they are moved or re-sized.
Snap positioning
toggle button
¥ Pas: Shows the horizontal position of a selected frame. If more frames are selected, the
horizontal position is only displayed if it is the same for all selected frames.
XP
08 To change the horizontal position of a frame, enter a new value in the X position field.
¥ Pos: Shows the vertical position of a selected frame. If more frames are selected, the vertical
position is only displayed if it is the same for all selected frames.
YP
08 To change the vertical position of a frame, enter a new value in the Y position field.

© Stibo Systems - Confidential 17
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Tool Description
Shows the width of a selected frame. If more frames are selected, the width is only
displayed if it is the same for all selected frames.
To change the width of a frame, enter a new value in the Height field.

Width:
Width
Height: Shows the height of a selected frame. If more frames are selected, the height is only
displayed if it is the same for all selected frames.
Height To change the height of a frame, enter a new value in the Height field.

Working with Frames in Page Templates
+ Toaddaframe to a page, select the Add Frame tool in the tool bar. Drag an outline of the frame with the

To Add a Frame
cursor while holding down the left mouse button, and then release the mouse button.

To Insert Frames on a Grid
To quickly create many frames in a grid, select a page, then click Insert frames on a Grid in the tool bar. A

1.
dialog box appears:

In the Across field, enter the number of rows of frames you want to be inserted.
In the Down field, enter the number of columns of frames you want to be inserted.

2.
3.

4.

In the Vertical Gap field, enter the distance between the rows of frames.
6. Click Enter. The frame grid is inserted on the selected page.

In the Horizontal Gap field, enter the distance between the columns of frames.

5.

To Select Frames

o Toselectaframe, click the Select tool in the tool bar and click a frame.
o To select multiple frames click the frames while holding down the shift key.

« Todelete a frame, select the frame with the Select tool and then click the Delete frame button in the tool

To Delete Frames
bar. You can also select multiple frames and delete these frames the same way.

To Move Frames
« Tomove aframe, choose the Select tool in the tool bar, and then drag and drop the frame. You can also set

the X and Y position of one or more selected frames by entering a new value in the X Position field and Y

Position field.
18
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To Resize Frames

« Toresize aframe, choose the Select tool in the tool bar, select the frame, and then drag the handles on the
frame border. Alternatively, enter a new value for one or more selected frames in the Width and Height
fields in the tool bar.

To Enable Snap Positioning
When you move frames on the page using drag and drop, it can be useful to enable Snap Positioning. This makes
the moved frame snap to a position when you release the mouse button. This way you can easily place frames in
the same X and Y positions on the page. The snap positions are :

« Margin borders: Upper and right hand side border

o Frame borders: All borders

Note: Only the upper frame border and the left hand frame border of the frame that is being moved snaps.

To Change the Order of Frames
Frames are placed on the page in a specific order relative to each other. Adding a new frame places that frame on
top of other frames. This is only noticeable if frames overlap each other.

If you want to change the ordering of frame layers, right-click the frame, select Layers, and select one of the four
options:

« Bring to front: Brings the selected frame to front.

« Send to back: Sends the selected frame to the back.

« Bring forward: Brings the selected frame one level forward.

« Send backward: Sends the selected frame one level backward.

Note: Moving a frame from one page to another brings the frame layer to a front position.

To Change Frame Properties
To view and maintain details of a frame, select the frame, right-click and select Frame Properties. A dialog box
appears with the following options.
« Frame ID: Editable field that shows the ID of the selected frame.
+ X Position: Editable field that shows the horizontal position of the selected frame.
« Y Position: Editable field that shows the vertical position of the selected frame.
« Width: Editable field that shows the width of the selected frame.
Height: Editable field that shows the height of the selected frame.

Layer: Editable list that defines the frames order relative to other frames on the page. '0' means that the
frame is in the back.

To View Frame IDs
Each frame on a page template has an ID.

© Stibo Systems - Confidential 19
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« Toview the ID of the frames on a page, right-click the page and select Show Frame IDs. A small box
containing the IDs appears in all the frames on the spread.

To Change Frame IDs

« Tochange the ID of a frame, right-click the frame and select Frame Properties. A dialog box appears
where you can change the ID.

To Change Margins

« Tochange the margins of a page template, right-click the white area on the page and select Margins. A
dialog box appears where you can set the margins. You can choose if the changes should apply to the whole
spread or only to the selected page.

« Toapply the changes to the selected page, click Left if you have selected a left-hand page or Right if you
have selected a right-hand page.. To apply the changes to both the left-hand and the right-hand page, click
Spread.

If you want to enter the same values for Top/Bottom/ Inside/Outside margins,make sure the padlock button is
enabled (locked).

To Zoom In and Out
« Tozoomin, right-click the page and select Zoom In.
« Tozoom out, right-click the page and select Zoom Out.

To Copy and Paste Pages
Itis possible to copy and paste a page including frames:

1. Right-click the page you want to copy and select Copy Page.
2. Right-click the page you want to paste the copied page to and select Paste Page.

The copied page including frames is pasted.

Note: A warning appears if you try to paste a left-hand page to a right-hand page and vice versa.

Creating Page Templates in InDesign
This section describes how to create a page template in InDesign, apply layout styles to a page, and how to store
the page template locally and/or in STEP. Page templates are only used in conjunction with STEP Flatplanner.

A page template allows you to define the layout style of a page. It defines:

« Where you are allowed to place a product with its product template.
« How many products you are allowed to place.
« Where you can place images.

« Where you can place free text.

Though it is strongly recommended to create page templates directly in the Page Template Designer tool in the
STEP Workbench, there are certain exceptions where the page template must be created in InDesign:
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+ Galley page templates must be created in InDesign

« Page templates where styling is needed in the Flatplanner frames must be created in InDesign, though this
is uncommon. Typically, all styling is handled on product templates and publication templates / mounting
pages.

« Layouts where Flatplanner frames must be very precisely aligned against each other with no or extremely
little space in between (also uncommon, but may be helpful for layouts such as coupon flyers). Using

InDesign to create these types of page templates will give a much more precise level of control over frame
alignment than what is available in the Flatplanner.

Note: Before you can use InDesign-created page templates with STEP Flatplanner, the templates must first be
saved back to STEP and assigned to a publication.

Creating a Page Template in InDesign
To create a page template in InDesign:

1. Create a new InDesign document that has the same page size and margins as the publication template being
used in the publication.

2. Checkthe Facing Pages check box to create a spread.

3. Navigate to STEP > Template Type and choose Page Template.
BE B sien v | v =y B

) e [+
(O] [»] | [ m— ]

Connect to DB ...
I Reload

Change Version ...

Ao

Az sk

ik

Preferences ...

Template Type > Publication Template
Update Document Data ... v F'ageTempIate_r
Layer Version Update ... Pru:uduct?emplate

Check DB Update ...

Applying Frames to the Page Template

To complete the page template, frames must be added to it. Frames are added from the STEP Template Frame
palette.

1. Openthe STEP Template Frame palette by navigating to Window > STEP Template Frame.

2. Draw either a text frame using the Type tool (T) or an image frame using the Rectangle Frame tool (F).

3. With the frame selected, choose the desired frame type from the Frame Type dropdown list. The following
screenshots show the available options for image frames (L) and text frames (R).
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4. Repeat step 2 - 3 for each element you want to allow on the pages in your publication.

When the pages with the different frame types are viewed in the Flatplanner Plan view, each frame type is
represented by a colored square. For more information about the Flatplanner and the colored squares, see STEP

Flatplanner User Guide.

For more detailed information about the different frame types, see the STEP Template Palette Parameters for
Page Templates section of the Flatplanner documentation.

Storing the Page Template

Once you have created a page template, it must be saved to STEP in order to use it in conjunction with
Flatplanner, as well as to make it available to other STEP users.

To store the template in STEP:

1. Save the InDesign document on your local hard drive as a standard InDesign file (suffix .indd).

2. Inthe STEP menu, click 'Save Document to DB.' A Save Document to STEP Database dialog box appears.
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Save Document to STEP Database
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[l Close document and delete local copy
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3. Select the publication group you want to save the document to, then select Save as Page Template from the
dropdown list.

4. Click OK.

STEP Template Palette Parameters for Page Templates

Note: Page templates are only relevant if using Flatplanner.

Note: Itis recommended to create page templates directly in the Page Template Designer tool in the workbench.
An exception to this is if you want to create a page template used for Galley pages.

You can set a few parameters (lower half of the STEP Template Palette panel) to control how the elementis
referenced into the page template.

Frame Type: Use this option to define the layout style for the different elements on your page template. The
frame type determines what kind of elements are allowed on the pages in a publication when working in the
Flatplanner in STEP Flatplanner. You can choose between:
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« Static (e.g. Logo, Brand)
o Galley text
o Galleykey letter (e.g. A, B, C)

Note: When defining a Galley key letter, you must also define a value (integer) in the field next to it, in order to
have Galley text and Galley key letter automatically placed in the right order.

« Image
e Product
o Free Text

¢ Product or Image

When the pages with the different frame types are viewed from the Flatplanner in STEP Flatplanner, each
frame type is represented by a colored square. For more information about the Flatplanner, see STEP
Flatplanner User Guide.

Frame ID: A unique value is automatically generated in this field when a text/image frame is created on the
page template. The value is editable.

Galley Templates

The 'galley' format is a common layout style for retail catalogs. Galley layouts incorporate the use of Key Letters,
which connect product images with the text that describes the product. To build a Galley Page layout in STEP,
Galley Page Templates are used in conjunction with Galley Product Templates. Both types of Galley Templates
are supported by Flatplanner publications only.

The following is an example of a Galley Page created from STEP. Notice how images are separate from the text,
which appears at either the bottom or the side of the page. Each image is identified by a Key Letter (A, B, C, etc.)
that correlates it to the corresponding text across the bottom or the side of the page.
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Galley Page Templates

Unlike standard page templates, which are typically created in the workbench, Galley page templates are created
in InDesign.

Galley page templates use key letters, which must be designated in the page template in InDesign.

The following types of frames are used in Galley page templates:

1. Galley key letter
2. Image frame

3. Galley text frames

Optionally, Galley page templates can also contain the following additional frame types:

« Textframes containing attribute references
« Standalone image frames that are not connected with key letters

« Standalone product frames that are not connected with key letters and can be linked to non-Galley product
templates

For more information on these optional frame configurations, see the Advanced Galley Page Template Frame
Options section of the Galley Templates documentation.
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Grouping and Configuration of Key Letters and Image Frames

Galley page templates typically use three types of frames: image, Galley key letter, and Galley text.

Image Frames

Image frames should be configured in the STEP Template Palette to call out an image reference type. This is
nearly identical to product template functionality. A frame type is not assigned to the image frame. (The only time a
frame needs to be designated as an 'image' is if an image asset will be dragged directly into that square in the
Flatplan.) Best practice for images on Galley pages is to only use one image per reference type. Note that Frame
IDs are automatically generated, as they must always be unique.
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Galley Key Letter Frames
The Galley key letter frame should be a standard text box with the letter / number manually entered inside. This

frame must be designated as a Galley Key Letter. The number indicates the order in which products should
appear on the page. For this example, box A will be 1, box B will be 2, and so forth.
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The image and Galley key letter frame must next be grouped together. A frame type does not need to be assigned
to the grouped frames.

STEF | & STEF Template Palette

Templste Type  Page Template -

| [(Beerh |
[ 3 Antribute Groups -

[+ 2] Refereme Types

[] Keap With Nest

Context: -

~ =

Frame ID |10767 |

Galley Text Frame

In this example, the text frame is a single text frame across the left-side of the page. It will be designated as a
Galley Text frame. Since text from all products will go into this single frame, it does not need a number
designation.
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Saving the Galley Page Template to STEP

[ 5] Arribute Groups o
[» 5 Reference Types
[] Keep With Next
& Context: -
Frame Type:  Galley Test - 0

StiboSystems

The Galley page template will be saved to STEP from within InDesign. It will be saved as a page template to a

publication group folder. See the Page Template section of the STEP'n'design documentation for more
information on saving page templates to STEP.
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Galley Product Templates
Galley product templates differ from standard product templates in that image frames are not included on Galley
product templates. Images for Galley pages are handled by Galley page templates instead.

Key Letter and attribute (i.e., textual) content is all that appears in Galley product templates. All content is placed
inside a single text frame.

To add the Key Letter tag to the product template, navigate to Object Properties > Keyletter in the STEP
Template Palette in InDesign. Then, drag the Keyletter 'attribute’ onto the page. Other attributes will be added into
the text frame as per standard product template procedure.

For more information on building standard product templates, see the Product Template section of the
STEP'n'design documentation.
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Working With Galley Page Templates in STEP

The following screenshot shows what a Galley page template looks like on the page template Designer tab. The
green frames indicate Galley Text frames. Note that no image frames appear on the page.

Unlike the frames contained in standard page templates created in the workbench, green Galley text frames
cannot be manipulated in the page template designer.

This section will explain the special handling involved in linking product objects to planned pages that use a Galley
page template to drive the layout.
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Linking Products to Galley Text Frames

Unlike standard Flatplanner planned pages, there is not a 1-to-1 relationship between product objects and
Flatplanner frames when using Galley layouts. All products that should appear on a page are linked into a single
green Galley text frame. In other words, there is a 1-to-many relationship between Galley frames and product
objects.

In the Plan view, product objects should be dragged into Galley frames in the order that they should appear on the
planned page. In the example below, there are three products inside a single frame. The product on the top will be
the first product, i.e., Galley key letter A. The second product will be Galley key letter B, and so on.

Note: Ordering product objects in Galley frames may involve some removal and re-adding, as the products
cannot be rearranged once placed into the frame. One way to ensure that your product objects appear in the
correct order is to arrange them in the Flatplanner basket first, then multi-select them and drag them onto the
frame together.
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Assigning Galley Product Templates to Products in a Galley Frame
1. Right-click in a white area on the planned page and select View > Show Product Templates.

2. Left-click in the white product template box on the frame and choose the Galley product template that you
would like to use in the Choose a Product Template dialog.
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Galley product templates may also be pre-assigned to product objects through Flatplanner pagination rules. The
following screenshot shows an example of a rule that has been set to use a Galley product template as the default
layout. For more information on Flatplanner pagination rules, see Pagination Rules for Flatplanner in the

Flatplanner documentation.
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Use product template Doc-Dev PRODUCT

Template GALLEY
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Mounting the Galley Page

Galley pages are mounted like any other Flatplanner page in InDesign. For more information, see Finalizing
Pages in InDesign in the Flatplanner documentation.
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Advanced Galley Page Template Frame Options

Text frames containing attribute references, as well as additional image frames containing product or asset
references, may be grouped together with the image frame and Galley key letter frame. In addition, any frame
appearing on a Galley page template may be styled with background shading, borders, and so forth. This allows
more flexibility in the layout of Galley pages, since Galley product templates may only contain text. (See the Galley
Product Templates documentation for Galley product template configuration instructions.)

The following screenshots show a 'before' and 'after' of a more advanced setup. The first screenshot shows the
stylized page template, and the second screenshot shows the mounted page in InDesign:
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Image and Product Frames Without Key Letters

In addition to the frame types required for Galley layouts, other frame types may be 'nested' within the page to
allow expanded layout flexibility.

The following Galley template example shows three additional frame types:

1. Static
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2. Image (no Key Letter)
3. Product

VT oduct Irage
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Static Frames

Static Frames are used for content that should never be manipulated in the workbench Plan view. They typically
contain logos or brand images.
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Image Frames are not connected to Key Letters and are intended to contain image assets only.
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Product frames allow 'nesting' of content on a page, allowing a different, non-Galley product template to be linked

to the frame.
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Working With Optional Galley Page Template Frame Types in the Workbench

To prevent manipulation by users in the workbench, Static Frames do not appear in the Plan view. Numbers 2
and 3 on the below screenshot show the product and image frames from the previous example.
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The following screenshot shows the Plan with an image object linked to the Image Frame and a product object
linked to the Product Frame. Note that the product template applied to the product frame is a non-Galley
template.
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The document described in this example will appear as follows when mounted in InDesign:
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Note: To apply more advanced product template-style parameters to image and text frames on Galley page
templates (e.g., image alignment settings and Delete Before / Delete After text options), you can temporarily
change the Template Type to 'Product Template' in the STEP Template Palette. Once your template is complete,
you must change the Template Type back to 'Page Template' before saving it back to STEP.

For more information on all frame parameters available for page templates created in InDesign, see the STEP
Template Palette Parameters for Page Templates section of the Flatplanner documentation.
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Pagination Rules for Flatplanner

A pagination rule is a rule that controls how, when, and where product presentations are added to a page.

A pagination rule consists of one or more conditions and an action that takes place if the condition is met. You also
have to specify detailed criteria for some of the conditions and actions.

Pagination Rule Groups
There are two different pagination rule groups available in Flatplanner:

« Object layout

« Set publication template spread index

Pagination Tab
You add pagination rules on the Pagination tab, which is available when you select a publication, section, or
subsection in the tree.

On the Pagination tab, there is a table which displays all rules that are applied to a publication. You get an
overview of all conditions and actions, and you can see where in the publication structure the rules are defined.

If there all rules with in a rule group are overridden, they are displayed in green. If you have edited the action of an
inherited rule, it is displayed in red.

Pagination Rule Inheritance

Pagination rules are inherited from higher levels to lower levels. Rules that are applied at lower levels take
precedence over rules applied at higher levels. So if you have applied a rule at publication level it is inherited to
sections and subsections, but rules applied at section or subsection level takes precedence over the inherited rule.

Important: All rules within a pagination rule group are effected when your create a local rule. Therefore, if you
make changes at publication level, the changes are not inherited by lower level sections and subsections.

Pagination Rule Evaluation

Pagination rules are evaluated one by one in the list from top to bottom. When the condition of a rule evaluates to
True, the associated action is then evaluated. The layout of a page is decided by the sum of all conditions with
actions that evaluate to true.

Note: The order of evaluation means that one action can override an action associated with a rule further down in
the list. Therefore, you should always specify the rule with the more general rule first and the most specific rule
last.

To Change the Evaluation Order of Pagination Rules

« You can change the order of evaluation by clicking the rule you want to move, and then drag and drop it to its
new position in the list.
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Adding Pagination Rules
To add a pagination rule, use the following steps.

To Add a Pagination Rule

1. Inthe Tree, expand the publication hierarchy, and then click the publication that you want to add a pagination
rule to.

2. Clickthe Pagination Rules tab.

3. Click Add Rule Group. The Configure Rules dialog appears where you can define the rules.

¥ =

E] Configure Rules @

Ackion Group [ w |

Set Condition
Condition »

A Condition

Set Action
Bekion ¥

A Action

Ok, Cancel

4. Fromthe Action Group list, select the rule group that you want to apply.
5. Inthe Set Condition Area, click Add Condition. The Rule Condition dialog appears.

E] Fule Condition @

Select Condition

Default condition L

l i, H Cancel

6. Inthe Select Condition list, select the relevant condition, and then click OK.

Some conditions can be limited further. Click the blue, underlined text to enter the criteria that determine when
the condition should be applied.
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Condition ¥
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7. Inthe Set Action area, click Add Action. The Rule Action dialog appears.

rE] Rule Action ﬁq

Select Action

Use product template -

[ Ok ” Cancel

8. Inthe Select Action list, select the relevant action, and then click OK.

Some actions can be limited further. Click the blue, underlined text to enter the criteria that further defines the
action.

Set Action
Wction >

* [Use product tﬁnplatﬂlmnduct tmnglatf:-l

To Add Local Pagination Rules
Itis possible to add local rules to a rule group at a lower level in the tree.
« if you add a rule to a group with inherited rules, a message is displayed asking if you want all rules in that
group to become local. Click Yes to make all rules local.

Allrules in the rule group are then displayed in green in the list. As a result, the rules will no longer inherit changes
made to the rules at a higher level.

Tip: Toremove local rules, remove all the rules in a group one by one. The rule group reverts back to the inherited
rules.

Editing Pagination Rules

You can edit both local and inherited pagination rules. On local rules, you can change both conditions and actions,
but on inherited rules you can only change the actions.

To Edit Pagination Rules
1. Inthe Tree, click the publication, section or subsection whose rule you want to edit.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to edit, right-click, and then select
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Edit Pagination Rule. The Configure Rules dialog is displayed.
3. Make the desired changes, and then click OK.

If you have changed the action on an inherited rule, it is now displayed in red in the list on the Pagination Rules tab.

Note: You can not edit or add or delete conditions on inherited rules. Also, you can not add or remove actions
from inherited rules.

To Override Inherited Rules

To make all rules within a rule group local, you can override inherited rules. If local inherited rules are overridden,
changes made at higher levels are not inherited to the level where the rules have been overridden.

1. Inthe Tree, click the publication, section or subsection whose rules you want to override.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to edit, right-click, and then select
Override Rules.

The rules are overridden and displayed in green in the list. You can now edit the actions and conditions on the
rules and you can edit and remove rules from the rule group.

To Remove a Pagination Rule
1. Inthe Tree, click the publication, section or subsection that you want to delete a rule from.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to edit, right-click, and then select
Remove Pagination Rules.

To Copy Pagination Rules

Itis possible to copy a rule from one rule group to another. Rules can be copied to and from publications, sections
and subsections. The paste destination does not have to be of the same type as the source.

1. Inthe Tree, click the publication, section or subsection that holds the rule you want to copy.

2. Onthe Pagination Rules tab, click the arrow icon next to the rule you want to copy, right-click, and then select
Copy Pagination Rules.

3. Omthe Tree, click the destination publication, section or subsection.

4. Onthe Pagination Rules tab, click the arrow icon of an existing rule, right-click, and then select Paste
Pagination Rules.

Note: If you paste a local rule into a group with inherited rules all rules in the group become local.

Pagination Rule Actions
For each rule group, a number of actions are available.
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Object Layout Actions

Action Description

Keep user assigned template Uses the already assigned template.

Pickup document Uses a product layout from a publication that you select.

Use default product Uses the default product presentation that has been assigned to the product.

presentation

Use product template Uses a specific product template that you select from a list of available
templates.

Set Publication Template Spread Index Actions

Description

Set publication template spread index | Defines which spread within a publication template to use.

Pagination Rule Conditions
The following table describes the pagination rule conditions that are available in the Flatplanner

Condition Description

Default condition The rule is always applied. There are no specific conditions that
must be met.
If firstin section The rule is applied if the object is the first object in the section

specified in the condition.

If frame dimensions fit product template The rule is applied if the width or the height of the frame meets the
min/max dimensions conditions you specify.

If the object type is The rule is applied if the object is of the same object type as
specified in the condition.

If the object is The rule is applied if the object is the same as the object specified
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Condition Description

in the condition.

If the product attribute value equals The rule is applied if the product attribute value is the same as the
value specified in the condition.

Pagination Rule Groups

There are two pagination rule groups that you can apply in Flatplanner. For each group, there are a number of
actions available. For more information about actions, see Pagination Rule Actions.

Object Layout
Use the object layout rule to specify the layout of an object on a page.

The following conditions are available.

o Default conditions

« [ffirstin section

« Ifframe dimensions fit product template min/max dimensions
« Ifthe objecttypeis

« Ifthe objectis

« Ifthe product attribute value equals

Set Publication Template Spread Index
Use the set publication template spread index to specify which publication template spread number to use in the
mount process.

The following conditions are available.

o Default conditions
« Ifobjecttypeis

« Ifthe product attribute value equals

Flatplanner Baskets

Flatplanner baskets are a way to store and organize products and images (and less commonly, classifications)
that will be linked to frames on Flatplanner planned pages throughout a publication. Baskets can be accessed at
the publication, section, and spread level of publications.

The most common use for Flatplanner baskets is the ability to view the assortment of products that have been
selected for your spread, section, or publication, then drag these objects from the basket onto the frames on your
Flatplanner planned pages.
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Baskets are optional, as objects may be linked directly to planned page frames by a number of different methods:
directly from the Tree, from a listing of search results, from the contents of a collection, and through a Flatplanner
Excel or Publication Excel import. However, Flatplanner baskets are a convenient visual tool for users who plan
pagesin STEP, as basket views can be configured to display image thumbnails, attribute values, commercial data
(such as pricing), and other useful information about the product selection.

Objects linked to baskets at higher levels in the publication hierarchy are inherited by the baskets of child sections
and spreads, following the same manner of inheritance as that of other hierarchies in STEP (for example, how
attributes and references that are linked to higher levels in the product hierarchy are inherited by child products).

Viewing a Basket
Baskets are viewed from the Plan tab on publications, sections, and spreads.
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« Toopen the basket, click Show basket in the upper right corner of the basket window.
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« To hide the basket, click Hide in the upper right corner of the basket window (visible in the first screenshot in
this topic).

Adding Objects Manually to Baskets

Products, assets, and classifications can be added to Flatplanner baskets through both manual and automated
methods. The following instructions outline how to add objects to Flatplanner baskets manually: from the Tree,
from search results, and from collections.

For all of the following methods, the relevant basket must be open (unhidden) and the Plan editor must be pinned
to the window by clicking the thumb pin icon in the upper left corner. H

To Add Objects From the Tree

1. Inthe Tree, locate the relevant publication, and then navigate to the level of the publication that contains the
basket to which you would like to add objects. (This is typically a section or spread, but could also be at the top
publication level.)

Click the Plan tab.
Click Show basket to make the basket available.
Ensure that the editor is locked by clicking the thumb pin icon in the upper right corner of the Plan window.

In the Tree, navigate to the object(s) that you want in your basket.

o g k& w DN

Select one or more objects, then hold down the left mouse key and drag the object(s) into the basket. To select
multiple objects, press Ctrl or Shift while making selections.

To Add Objects from a Search Result

1. Follow steps 1-4 from the previous section to locate, open, and pin the relevant basket.

2. Click on the Search tab, make your selections, and then click Search.

3. Select one or more objects, then hold down the left mouse key and drag the object(s) into the basket. To select
multiple objects, press Ctrl or Shift while making selections.

Search < Party Hats - Plan

] [Search Below = Primary Product Hierarchy ™ ||| AutoPage Publication Plamner || Pagination Rules || Page Inspector
Hl| - [Sezrch = | Publication Section l l Publication Planner ” Flant
*

= Hat Basket at:Acme Party Supplies

E & Advanced . .

g Column View: | pefault - Public -
(2p ’ Reset ” Search l : .

5| Displaying 22 of 22 results Show Details D * Name > PrimaryProduct.t.On Pages

o || [Mame

& 121171 Pink & Gree... 2, 4

% I 1st Birthday Hat D = 134420 B Pink & Gree 5%

=] Baseball Hat D = 205805 — -

& ——

Ty|a. Black Top Hat D = 137730 121178 = Purple & W... 3,7
* | > \™Blue & Pink Owl Party Hat D = 132494

3_ I Blue & Yellow Balloon Hat D = 1271180 s

5 ||> Lu/Blue Top Hat 1D = 132485 4| Al
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For more information on how to conduct searches in the STEP Workbench, see the Search Overview section of
the STEP User Guide / Getting Started documentation.

To Add Objects from a Collection List

1. Follow steps 1-4 from the 'To Add Objects From the Tree' section above to locate, open, and pin the relevant
basket.

2. Inthe Tree, navigate to the relevant collection and expand it to view its contents.

3. Select one or more objects, then hold down the left mouse key and drag the object(s) into the basket. To select
multiple objects, press Ctrl or Shift while making selections.

Tree £ Party Hats - Plan
%03 Primary Product Hierarchy (Pro » ||| page Inspector || Status || State Log || Tasks
E"' g”aeczmns AutoPage Publication Planner i P:
+- [ Beds
" 5 Copy Writing State Publication Section lml Publication Planner H Plan Notes l
" i Data Quality Collection Basket at:Acme Party Supplies
- [ Digital Asset Review State ] ]
- 5 Hats Column View: | pefault - Public -
- \™ 109308 (109308) : :
L 1112121-1 (17739) . D * Name * PrimaryProductImage > |On Pages
-\ 12-GGK79 (100703) =
| 18207-011 (18207 121171 I Pink & Gree... {@i 2, 4
-\ 18210 M B (18210) . > &3
- \fm 18212 L B (18212) 3
18213 M O (18213) 121178 B Purple & W... 3,7
-l 18214-012 (18214)
-l 18215-012 (18215) B i
- 18216 L O (18216) < | 1l |

For more information on how to create and work with collections, see the Collections and Collection Groups
section of the STEP User Guide / Getting Started documentation.

Removing Objects from Baskets

1. Select the row(s) containing the products that you would like to remove by clicking the cells under the ID
column. Rows may be multi-selected by holding Shift or Ctrl while making selections. (Note: Cells in any
column may be clicked to select rows, though using the ID column is the most logical, since it is the first column
and also contains no hyperlinks.)

2. Right-click and select Remove.

© Stibo Systems - Confidential 51



StiboSystems

Publication Section ]m[ Publication Planner H Plan Notes H Financial Summary l

Basket maintained locally

Column View: | Default - Public - View Options
D o * Name * [PrimaryProductImage * |On Pages * Brand Name
23456-002 I B
34567-003 Filtering enabled

Caps Galore
20805 . 6, 10
Show in plan
9 Remove
< Import File b
Copy table to clipboard for Excel
I I —

Editing Data in Baskets

Itis possible to edit attribute values and commercial data directly in a basket. Attributes are only editable if the
attributes are valid for the product. Commercial data is only editable if the relevant commercial list is valid for the
publication and has been mapped to the publication version that you are working in. As with editing values in any
other location in the workbench, you must have the appropriate user permissions in order to edit values in the
basket.

[ Publication Section lm[ Publication Plarmer ” Plan Motes ” Financial Summary ” AutoPage Publication Planner H Pagin

Basket at:Acme Party Supplies

Column View: | Default - Public -

PrimaryProductImage * |On Pages * Brand Mame * |SalesPrices
Acme
2,4 2.49

W

D * Mame

121171 ﬁ Pink & Green Party Hat

by Parties Galore
121178 F Purple & White Party Hat 3,7 3.99

Inthe Tree, expand the publication hierarchy.

Click the relevant publication and expand the hierarchy.
Click a publication, section, or a spread.
Select the Plan tab.

A wbd -
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Click Show Basket to make the basket available.
Click the field in which you want to add or change the value.

Enter the new value.

® N o o

Click outside of the field. The value is saved.

Working with Frames in Publications, Sections, and Spreads

You can edit and add frames and content.
« Toeditframes, in the Tree, select the preferred publication, section, or spread, and then click the Plan tab.

To Add a Frame

+ Toaddaframe to a page, select the Add Frame tool in the tool bar. Drag an outline of the frame with the
cursor while holding down the left mouse button, and then release the mouse button.

To Insert Frames on a Grid

1. To quickly create many frames in a grid, select a page, then click Insert frames on a Grid in the tool bar. A
dialog box appears:

In the Across field, enter the number of rows of frames you want to be inserted.
In the Down field, enter the number of columns of frames you want to be inserted.
In the Vertical Gap field, enter the distance between the rows of frames.

In the Horizontal Gap field, enter the distance between the columns of frames.

© g s~ w DN

Click Enter. The frame grid is inserted on the selected page.

To Select Frames

o To select aframe, click the Select tool in the tool bar and click a frame.

o To select multiple frames, hold down the Shift key, and click the frames you want to select.

To Delete Frames

o Todelete a frame, select the frame with the Select tool and then click the Delete frame button in the tool
bar. You can also select multiple frames and delete these frames the same way.

To Move Frames

« Tomove aframe, choose the Select tool in the tool bar, and then drag and drop the frame. You can also set
the X and Y position of one or more selected frames by entering a new value in the X Position field and Y
Position field.

To Resize Frames

o Toresize aframe, choose the Select tool in the tool bar, select the frame, and then drag the handles on the
frame border. Alternatively, enter a new value for one or more selected frames in the Width and Height
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fields in the tool bar.

To Enable Snap Positioning
When you move frames on the page using drag and drop, it can be useful to enable Snap Positioning. This makes
the moved frame snap to a position when you release the mouse button. This way you can easily place frames in
the same X and Y positions on the page. The snap positions are :

« Margin borders: Upper and right hand side border

o Frame borders: All borders

Note: Only the upper frame border and the left hand frame border of the frame that is being moved snaps.

To Change the Order of Frames

Frames are placed on the page in a specific order relative to each other. Adding a new frame places that frame on
top of other frames. This is only noticeable if frames overlap each other.

If you want to change the ordering of frame layers, right-click the frame, select Layers, and select one of the four
options:

Bring to front: Brings the selected frame to front.

« Send to back: Sends the selected frame to the back.
« Bring forward: Brings the selected frame one level forward.

+ Send backward: Sends the selected frame one level backward.

Note: Moving a frame from one page to another brings the frame layer to a front position.

To Move Content Between Frames
You can move content such as products and images from one frame to another.

« Selectthe Select tool, in the preferred frame, click the object you want to move, and then drag and drop the
object to the desired frame.
To Remove Content from a Frame

+ Right-click the desired frame, and then click Remove Content.

To Change Frame Properties
To view and maintain details of a frame, select the frame, right-click and select Frame Properties. A dialog box
appears with the following options.

« Frame ID: Editable field that shows the ID of the selected frame.

« X Position: Editable field that shows the horizontal position of the selected frame.

« Y Position: Editable field that shows the vertical position of the selected frame.

« Width: Editable field that shows the width of the selected frame.
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+ Height: Editable field that shows the height of the selected frame.

« Layer: Editable list that defines the frames order relative to other frames on the page. '0' means that the
frame is in the back.

To View Frame IDs
Each frame on a page template has an ID.

« Toview the ID of the frames on a page, right-click the page and select Show Frame IDs. A small box
containing the IDs appears in all the frames on the spread.

To Change Frame IDs

« Tochange the ID of a frame, right-click the frame and select Frame Properties. A dialog box appears
where you can change the ID.

To Zoom In and Out

« Tozoomin, right-click the page and select the Zoom in option. To zoom out, right-click the page and select
the Zoom out option.

To Change the Size of a Frame
Itis possible to resize a frame on a spread.

To Copy and Paste Pages
Itis possible to copy and paste a page including frames:

1. Right-click the page you want to copy and select Copy Page.
2. Right-click the page you want to paste the copied page to and select Paste Page.

The copied page including frames is pasted.

Note: A warning appears if you try to paste a left-hand page to a right-hand page and vice versa.

Designing Frames for Publications, Sections, or Spreads

When you apply a template to a publication in the Flatplanner, it comes with a number of predefined frames.
However, it is possible to add or change frames on a publication, section, or spread. Use the Designer tool bar on
the Plan tab to add and position frames on the page template.

Designer Tool Bar

« Toaccess the Designer tool bar, click a publication, section, or spread in the Tree, and then click the Plan
tab.
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Tool Description

Used to save all changes

Save

E Used to select and move frames and content on the page by dragging them.
Select

[ Used to add new frames by clicking and dragging the mouse.

Add frame

[ Used to delete a frame. Delete is only enabled when one or more frames are selected.
Delete

T Used to insert multiple frames in a grid on the page.

Insert frames on

agrid

3 Used to undo your last action.

Undo

Cu Used to redo your last action.

Redo

o Used to enable or disable snapping of frames when they are moved or re-sized.

Snap positioning

toggle button

¥ Poss Shows the horizontal position of a selected frame. If more frames are selected, the
horizontal position is only displayed if it is the same for all selected frames.

X Pos

To change the horizontal position of a frame, enter a new value in the X position field.
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Tool Description

¥ Pos: Shows the vertical position of a selected frame. If more frames are selected, the vertical
position is only displayed if it is the same for all selected frames.

Y Pos To change the vertical position of a frame, enter a new value in the Y position field.

Width: Shows the width of a selected frame. If more frames are selected, the width is only
displayed if it is the same for all selected frames.

Width To change the width of a frame, enter a new value in the Height field.

Height: Shows the height of a selected frame. If more frames are selected, the height is only
displayed if it is the same for all selected frames.

Height

9 To change the height of a frame, enter a new value in the Height field.

Adding Products and Images to a Page

You drag and drop products, images, and classifications to a page from:

o Basket

e Tree

« Collection List
o Search Result

This topic describes the manual methods for linking objects to Flatplanner frames through dragging and dropping.
For information on how to link objects to Flatplanner frames through Excel imports, see Exporting and
Importing Flatplanner Publications in Excel in the Flatplanner documentation.

Dragging and Dropping from the Basket
You can drag and drop products and images from the basket to the Flatplanner.

Inthe Tree, expand the publication hierarchy.

Click the relevant publication and expand the hierarchy.
Click a publication, section, or a spread.

Click the Plan tab.

Click Show basket to make the Basket available.

o > 0=
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6. Drag and drop the relevant products or images from the basket to the Flatplanner.

Dragging and Dropping from the Tree

You can drag and drop products and images directly from the Tree to the Flatplanner.

1. Inthe Tree, expand the Classification hierarchy or the Product hierarchy and locate the product or image you
want to use.

2. Drag and drop the relevant product or image from the Tree to the Flatplanner.
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Dragging and Dropping from a Collection List
You can drag and drop products and images directly from a collection list to the Flatplanner.

1. Ensure that the editor is locked by checking the Thumb Pin icon & .
2. Inthe Tree, expand the relevant Collection hierarchy.

3. Drag and drop the relevant products or images from the collection list to the Flatplanner.

Dragging and Dropping from a Search Result
You can drag and drop products and images directly from a search result to the Flatplanner.

Ensure that the editor is locked by checking the Thumb Pin icon & .
In Search, define your search criteria and then click Search.

The search results are displayed in the Search Result window.

A wbd =

Drag and drop the relevant products or images from the search result to the Flatplanner.

Changing and Reapplying Page Templates

When you first create a publication, you define which page template you want to use in the publication.However, it
is possible to change the page template later, and to add different page templates to different sections or spreads
in your publication.

You can also reapply a page template to a publication, section or spread.

To Change a Page Template

1. Inthe Tree expand the Publication hierarchy, and then expand the relevant publication.
2. Click the relevant publication, section or spread, and then click the Plan tab.

3. Right-click a white area in the Promotion Planner, and then select Set page template. The Choose a Page
Template dialog appears.

4. From the list of available templates, choose the preferred template, and then click OK.

If you have changed a page template and want to switch back to the original page template, you can reapply the
page template.

To Reapply a Page Template

1. Inthe Tree expand the Publication hierarchy, and then expand the relevant publication.
2. Click the relevant publication, section or spread, and then click the Plan tab.

3. Right-click a white area in the Flatplanner, and then point to Layout, and then select Reapply page template.

If you have changed the position of frames on a page and you reapply or change the template, the frames on the
page are positioned according to the frame positions of the page template.
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While the position of a frame can change after changing the page template, the content of the frame remains the
same. If you have added additional frames with content, those frames will remain on the page as well. However,
frames without content are deleted.

Applying Product Templates

You can apply different product templates to different products, and you can change the assigned product
template.

To Add or Change a Product Template

1. Inthe Tree expand the publication hierarchy, and then expand the relevant publication.
2. Click the relevant spread, and then click the Plan tab.

3. Right-click a product (a light blue area) in the Flatplanner, point to Layout, and then select Set product
template. The Choose a Product Template dialog appears.

4. From the list of available templates, choose the preferred template, and then click OK.

E Choose a Product Template @

Select Template

Template1
Template2

Preview [ |

[ aK ][ Cancel ]

Note: All products must have a product template assigned, otherwise the products will not be mounted.

Itis also possible to add the same product template to all products on a page in one go.

To Apply the Same Product Template to all Products on a Spread

1. Inthe Tree expand the Publication hierarchy, and then expand the relevant publication.

2. Click the relevant spread, and then click the Plan tab.
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3. Right-click a white area in the Promotion Planner, point to Layout, and then select Set all product
templates. The Choose a Product Template dialog appears.

4. From the list of available templates, choose the preferred template, and then click OK.

Removing Product Templates

You can remove the assigned product template from a Flatplan frame by following these steps:

1. Inthe Tree expand the publication hierarchy, and then expand the relevant publication.
2. Click the relevant spread, and then click the Plan tab.

3. Right-click a product (a light blue area) in the Flatplanner, point to Layout, and then select Clear layout. The
template is removed from the frame.

Adding Notes and Free Text

Notes and free text can be added directly to planned pages (spreads) from the Plan tab. Notes and free text are
useful, for example, when you want to communicate with an art director or designer about the pages.

Notes can be added to planned page spreads in the Plan view and Preview view. They cannot be added in the
Sticker Book view.

m Planned Page ” Plan Motes " References " Status ” State Log " Tasks ]

R Eg | T‘Hx\ ¥ |'L"u':
Confe
48] 22
This i 2 Fres test frame
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To Add a Note to a Planned Page

In the Tree, expand the Publication hierarchy, and then click the relevant spread.

Click the Plan tab.

Right-click a frame or the white area of the spread, and then click Add Note. The Notes dialog appears.
Inthe New Message field, enter the text.

ok 0N =

Click Add, and then click Close. The note is visible in the frame or in the white space.

Note: Notes can be added to planned pages in both the Plan view and the Preview view. Free text can be added
in the Plan view only.

To Add Free Text to a Frame on a Planned Page

You can only add free text to empty frames, and you cannot add products to frames that contain free text.

Inthe Tree, expand the Publication hierarchy, and then click the relevant spread.

Click the Plan tab.

Double-click the free text frame, or right-click and select Set Text. The Add Text dialog appears.
Enter the text in the text field.

Click Add, and then click Close. The text appears in the frame.

o > 0o =

To Edit and Delete Free Text

« To edit free text, follow the same steps as you would to add free text.

« Todelete free text, right-click the free text frame and select Remove Content.

To Edit and Delete Notes From the Plan
« To edit a note from the Plan, double-click on the relevant note and add text.
« Todelete a note from the Plan, right-click the relevant note, and then click Delete Note.

« Instead of deleting a note, you may also mark it as Done. This allows you to keep the note while letting other
users know that no further action needs to be taken.
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P "

|2/ Notes (el

2015 11 04 16:45:13 DTPUSER:
Image has been replaced

2015 10 09 16:25:57 USER:
Wrong image

Done:

[New Message

[ Add H Close ]

Using the Plan Notes Tab

The Plan Notes tab enables the viewing, editing, and deletion of all planned page notes in one location. This tab is
accessible from the publication, section, and planned page level of publications. You can access all notesin a
publication from the publication level; all notes in a section from the section level; and all notes in a spread from the
planned page level.

Edits made to notes from the Plan Notes tab will be reflected in the notes attached to the Flatplan. Likewise, edits
made to notes on the Flatplan will be reflected on the Plan Notes tab.

Editing notes on this tab is similar to editing notes on Flatplan frames—new text can be added, but existing text
cannot be edited. The Plan Notes tab will always display the most recent notes text.

Note: Notes cannot be added to planned pages from the Plan Notes tab, as there is no way to position them on
the page. Notes can only be added via a right-click action on page spreads.

Spring Wedding Catalog - Plan Notes

Publication || Plan || Version || Pages || Publication Planner |BEEWIEEEM | Financial Summary || AutoPage Publication Planmer || Pagination Rules [_
Spread Title > Page * Top > Left * |User > [Comment > |Last edited > |Done >
[ Standard Publications - - -
o > Confett 4 43.98mm [78.89mm USER Please move this product to page 16 Fri Oct 09 16:28:39 EDT 2015 [
ﬁ Autopage Publications
{atplanner Publications L > Confetti 4 50.85mm |154.85mm USER  Please correct typo in copy Mon Oct 26 11:04:56 EDCT 2015 |:|
Spring Wedding Catalog ||| > confetti 4 108.56 mm 49.06 mm USER  Meeds new image Thu Oct 15 14:32:30 EDT 2015 [
Halloween Catalog » Confetti la 174.55mm 54.52mm USER  Replace with product EX-12345 Thu Oct 15 14:33:06 EDT 2015 [
= )
W Christmas Catalog > Confetti 5 42.62mm |146.44mm USER  MWrong image Fri Oct 09 16:25:57 EDT 2015 ||
WebUIPublicationTypes 52
e b > Confetti 5 46.70mm 46,70 mm USER  Please double chedk this copy Fri Oct 09 16:25:34 EDT 2015 [

To Edit or Delete Notes From the Plan Notes Tab

1. Select the note that you would like to edit or delete by left- or right-clicking on the small gray arrow at the
beginning of the row.

2. Inthe popup menu, choose 'Edit note...' or 'Delete note(s)'. Multiple notes may deleted at once if multiselected.
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Spring Wedding Catalog - Plan Notes

Publication [m Version || Pages || Publication Planner Financial Summary || AutoPage Publication Planner || Pagination Rul
Spread Title  » [Page  * [Top Left »[User ¥ |Comment » |Last edited » [Done
» Confetti 2 43.98mm [78.89mm |JSER Flease maove this product to page 16 Fri Oct 09 16:28:39 EDT 2015 [
» Confett 2 50.85mm |154.85mm USER Flease correct typo in copy Mon Oct 26 11:04:56 EDT 2015 |:|
uy i 2 ] LISER. MNeeds new image Thu Oct 15 14:32:30 EDT 2015 ||
» Confett Flﬁ Edit note... LISER Replace with product ABC-1234 Wed Oct 28 13:29:29 EDT 2015 [
> Confetti 3 Delete notels) | 1piser fimage has been replaced Wed Nov 04 16:45:13 EST 2015
» Confett 3 45, 70mm 46, 70mm  JSER Flease double chedk this copy Fri Oct 09 16:25:34EDT 2015 [

Sorting and Filtering Notes
Notes can also be sorted and filtered on the Plan Notes tab. Example use cases include:

« The placement of notes throughout a publication can be determined by filtering on Spread Title, then further
pinpointed by sorting on 'Left' and "Top' (X /Y coordinates.

« Allnotes that are marked as 'Done' can be identified by filtering the Done column on 'true'. The notes can
then be multiselected and deleted.

Spring Wedding Catalog - Plan Notes

[WW[W][T@SHW [ Financial summary || AutoPage Publication Planner || Pagination Rules || Page Inspector || Status [_
Spread Title  » |Page > [Top > |Left > |User ¥ |Comment » |Last edited Done
> |-all - - |- All - - |- All - - |-l - - |- Al - - |-l - - |-all - I Equals true - -
> Confett 3 L68inches  5.77inches  DTPUSER Image has been replaced Wed Nov 04 16:45: 13 EST 2015 |
> Confett 5 6.76inches  1.12inches  DTPUSER No further edits needed Pﬁfedﬂml'ﬂ‘i 16:50:51 EST 2015 |
> Napkins 4 2.57inches  1.90inches  DTPUSER No further edits needed P-‘edNnvﬂ‘IlE:SS:ZﬂESTZ!IS |
1 - 6.35inches  6.55inches  DTPUSER No further edits needed }m:dﬂwoq 16:55:04 EST 2015 |
M Edit note...
Delete note(s)

Navigation to Spreads

Spread titles are hyperlinked in the 'Spread Title' column. Simply slick on a hyperlink to navigate directly to the
Planned Page.

Publication || Plan || Ver

Spread Tile  ~|Page »

» Tabledoths 12

» Tabledoths 12
4

* Mapkins
* Mapkins 4
* Mapkins 5
* Confetti 2
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View Modes

Different viewing modes allows you to view the content and layout of planned and actual pages in different ways.

To Change the View Mode

1. Inthe Tree, expand the publication hierarchy, and then select a section or spread.

2. Onthe Plan tab, right-click in the white area, and then select the preferred view from the list.

View Mode Description

Show Plan Displays the allocated space and position for each type of object specified in the
template. The page is divided into colored squares where you can mount products or
images.

If you are using page templates created in InDesign, the frame types are
automatically converted into generic frame types that can be used for both images
and products.

Show Preview Displays a preview of how the product and images are positioned on the page based
on the product template applied to the frames.

The preview is created from the InDesign (DTP) server.

Show Sticker Book Displays products and images along with commercial data such as prices and sales
numbers. The commercial data is displayed as yellow sticky notes along with a
thumbnail image of the product.

If no commercial data is displayed, you must add the commercial data element to the
Sticker Book view.

Show Mounted Page | Displays how the actual pages look after the pages have been completed in the
InDesign and saved back to STEP.

This view is read-only.

Show Frame IDs Displays the frame id for each frame on the plan. You use the frame ids when the
importer is used to add objects to a frame.

Show Product Displays the product template that is assigned to each frame.
Template

Show Page Template | Displays the page template that is assigned to the page in the gray area above the
plan.
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View Mode Description

Show Page Spaces Displays how the page space is split and how the page spaces are assigned.

Highlight Differences | Is only active when preview mode is selected. Any differences between the current
Relative to Default layer and the default layer are highlighted by a gray box.
Layer

Customized Views

You have a number of options to customize views so that they are more efficient for you to work with. You can add
additional content, choose whether a view is private or public, and you can filter the data that is displayed.

You can customize the following views.
o Basket view
« Financial Summary view
« Sticker Book view

Customized View Content

You can add or remove the following view content.

Content Description

Element

Commercial Enables you to select a specific term type to be included in the view. A term is a combination
Data of a value and a set of conditions.

Attribute On Displays the attribute values of the selected reference type.

Reference

Attribute Value Displays the value of the attribute.

Calculation Enables you to specify a calculated attribute formula. The result of the formula is then
displayed in the view.

ID Displays the IDs of the objects.

Image Displays a thumbnail of the image.
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Content Description

Element

Name Displays the name of the objects.

On Pages Displays information about the pages the object is used on.

Product Count Displays information about the number of products in the view.

Space Usage Displays information about how much space a product takes up on a page.

Adding View Content

1.
2.

In the Tree, expand the Publication hierarchy, then select a section or spread.

On the Plan tab, select Sticker View from the View list, click Show basket, or click the Financial Summary
tab.

In the upper right corner, click View Options, and then choose Edit. The Edit View dialog displays a list of the
current view content elements.

Click an element, right-click, point to Add, and then choose the element you want to add. The eight most
recently used elements are displayed. To view more content options, click Other ....

& Edit View e

| Element

|
Edit |
Add » Calculation

.  Remowve Commercial Data

G R

Space Usage

Attribute Value

On Pages

Attribute On Reference
Product Count

Image

Cther ...

[ Ok H Cancel
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5. Click OK, to save the view. By default, the view is saved as a private view and is not available to others.
Some content elements are added immediately and require no further action. However, for each of the following
elements, a dialog is displayed where you have to specify more information.

Attribute On Reference
+ Fromthe Reference Type list, select the preferred reference type.
« Fromthe Attribute list, select the attribute whose value you want to be displayed.

Attribute Value
Click the ellipsis points (...), and then navigate to the preferred attribute.

Calculation

« Inthe Name field, enter a name for the calculation.

« Inthe Formulafield, click the ellipsis button (...), and then specify the preferred formula.

For detailed information about calculations and how to specify functions, see Calculated Attributes and Function
Editor in the Attributes section of the System Setup guide.

Commercial Data

« Inthe Data Type list, select the preferred data type.
« Inthe Break No. field, enter the quantity break number of the quantity span that you want to be displayed.
o For detailed information, see commercial data

« If your price list contains multiple prices for the same product covering different quantities and/or date spans
(also called quantity breaks), use the Group field to map the various price groups. Quantity breaks are
numbered from 1 and up.

Image

¢ In the Reference Type field, enter the type of image to be displayed.
e From the Size list, select the preferred image size.
Copying Views

In some cases it can be useful to copy an existing view before creating a new customized view. For example, when
you want to create a view that, with a few exceptions, is similar to an existing view. If you want to rename a view,
you also have to copy the view before you can rename it.

To Copy a View

1. Onthe plan tab,select Sticker View from the View list, or click Show basket or click the Financial Summary
tab.

2. Inthe upper right corner, click View Options, and then choose Copy. The Copy Column View dialog is
displayed.

3. Inthe Copy to ... field, enter the name of the new view, and then click OK. You can now select the view from
the view list.
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Deleting Views

1. Onthe plan tab,select Sticker View from the View list, or click Show basket or click the Financial Summary
tab.

2. Inthe upper right corner, click View Options, and then choose Delete. A dialog is displayed asking if you want
to delete the view. Click Yes.
Filtering Options

Filters allow you to view a subset of data. Instead of viewing all data in Basket view or Financial Summary view,
you can choose which data you want to see at any given time.

To Filter Information

1. Onthe plantab, click Show basket or click the Financial Summary tab.

2. Right-click a column header, and then choose Filtering enabled. A row with filtering options is added.

3. Inacolumn, click the arrow + , and then choose the preferred filtering options. You have the following options.

Filter Options Description

All Displays all data.

Empty Values Displays only fields with empty values.

Non Empty Values Displays only fields with values.

< (less than) Displays only values that are less than the number you specify.

> (greater than) Displays only values that are greater than the number you specify.
Contains Displays only values that contain the string you specify.

Equals Displays only values that match the text you specify.

Begins with Displays only values that begin with the text you specify.

Ends with Displays only values that end with the text you specify.

Public and Private View Options

Views can be public or private. Public views are available to all users. Private views are only available to the user
who created them.
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To Make the Current View Public

1. Onthe plan tab, select Sticker Book from the View list, click Show basket, or click the Financial Summary
tab.

2. Inthe upper right corner, click View Options, and then choose Public or Private.

« When you select Public, all users can select the view from the view list in the upper left corner. A Public view
has "- Public" appended to its name.

« When you select Private, the view is only available to you from the view list in the upper left corner.

Restrict Users From Maintaining Public Views
Users may not create, edit, or delete Public views of the Basket, Sticker Book, or Financial Summary unless they

have the privileges to do so. The following three User Actions enable these privileges:
« Maintain public basket view
« Maintain public financial view
« Maintain public stickerbook view

[ action et [

* Maintain GD5M publications

* Maintain GOSN registrations
» Maintain packaging hierarchy

Maintain public basket view
Maintain public finandal view

Maintain public stickerbook view

» Manage autopage objects

* Manage layout in page inspector

Users who are not granted these privileges will have the option to maintain individual Private views only, thereby
blocking the possibility of a user saving a Private view over a Public view. Non-privileged (restricted) users may
copy a Public view and configure this copy to their individual preferences, but this copied view will be Private and
only visible to the user who created it.

In a Public view, the following View Options commands are disabled for restricted users: Edit, Delete, Public,
and Private.
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l Publication Section ]m[ Publication Planner " Financial Summary ]

Column View: I :Default - Public | - Copy
i * Mame Edit él
I-SalesTtem-1111 N 2C-YLISO0A .
I-SalesItem-1121 N 2\ C-XNPR 746 ﬂ i
[-Salesltem-1122 N C-YFXNGTS Delete | I
I-SalesItern-12111 B - JNG551- 168K 7 oubic
I-SalesItem-12112 PN 2o JN5551-168U _
[-SalesItem-12113 PN AC-JNG551-32BK Private § [
I-SalesItem-12114 M - JNG551-32BU
I-SalesItern-13111 B 2\C_P7000-55

In a Private view, Edit and Delete are enabled, but Public and Private remain disabled.

See the About Privilege Rules section of the System Setup / Super User documentation for more information
on the setup and configuration of user privileges.

Removing View Content
Just as you can add view content, you can remove view content as well.

1. Activate Basket view, Financial Summary view or Sticker Book view.

2. Inthe upper right corner, click View Options, and then choose Edit. The Edit View dialog displays a list of the
current content elements of the view.

3. Click the element you want to remove, right-click, choose Remove, and then click OK.

Sorting and Show Options in Basket View
By using the sort options, you can arrange the data in Basket view in ascending or descending order.

1. Onthe plantab, click Show basket or click the Financial Summary tab.

2. Right-click a column header, and then choose the preferred sort order.

o Sort ascending: sorts alphabetically from A to Z or from the smallest to largest number of data.

o Sortdescending: sorts alphabetically from Z to A or from the largest to smallest number of data.

In Basket view, you can also choose to see where an object is used in the planned pages.

« In Basket view, right-click a column, and then choose Show in plan. The object is selected in the planned
page.

Reusing Saved Layouts

When a document has been finalized in InDesign, and saved back to the STEP database, you can reuse the
layout of that document.
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There are two ways of reusing layouts.

« Keeping the finalized layout of the actual page that matches the planned page.
« Using the layout of a different publication that has been saved back to the STEP database.

Keeping the Saved Layout of an Actual Page

When a document that has been finalized in InDesign is saved back to the relevant publication in the STEP
database, the product layouts of the planned pages are automatically picked up from the actual pages. This means
that the product layout defined for the mounted products on the planned pages is overridden.

o Todetermine if a product uses a saved layout, select Plan view, and then Show Product Templates view.
Keep Layout is displayed at the bottom of the frame instead of the name of the product template.

You can revert to the old layout of the planned pages because the old layout rules are overridden but not deleted.

To Revert to the Planned Layout

1. Inthe Tree, expand the publication hierarchy, and then click the preferred section or spread.

2. Onthe Plan tab, right-click the white area of a page or select a product frame and right-click the frame.
3. Pointto Layout, and then select Revert to Planned Element Layout.

The layout of the selected product or all products on the page reverts to the planned layout. When you view the
name of the product template, a T: is displayed.

To Switch Back to the Saved Layout

« Onthe Plan tab, right-click the white area or select a product, and then right-click the product.Point to
Layout, and then select Keep Saved Element Layout.

Using a Saved Layout from Another Publication

You can reuse layouts from all publications that have been saved back to the STEP database after having been
finalized in InDesign. This is called Pickup Layout. You can pickup both product and page layouts.

Finalized documents are located in the tree in a node called DTP Documents under the associated publication.

To Pickup a Saved Page Layout
1. Inthe Tree, expand the publication hierarchy, and then click the preferred section or spread.
2. Onthe Plan tab, right-click the white area, point to Layout, and then select Pickup Page Layout.

3. Inthe Pickup Page Layout dialog, navigate to and expand the relevant publication and DTP Documents
folder, and then click the preferred page. A preview of the selected page is displayed.
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1. Click Use Selected to apply the layout to the planned page.

To Pickup a Saved Product Layout

1. Inthe Tree, expand the publication hierarchy, and then click the preferred section or spread.
2. Onthe Plan tab, select the frame that contains the object that you want to apply the layout to.
3. Right-click the frame, point to Layout, and then select Pickup Layout.
4

. Inthe Pickup Layout dialog, navigate to and expand the relevant publication and DTP Documents folder,
and then click the preferred page. A preview of the selected page is displayed.

5. Click Use Selected to apply the layout to the product.

If you decide that you don't want to use the product or page layout that has been picked up, you can revert to the
planned layout as described previously.

Finalizing Pages in InDesign

Pages created with the Flatplanner can be finalized in InDesign. You can use the standard InDesign tools in
combination with the STEP'n'design plug-ins. The STEP'n'design plug-ins enable you to connect to the STEP
database and work with InDesign documents as dynamic documents.

This has a number of advantages:

« You have access to approved text and images that are ready for layout
« You can view notes and comments added to the pages in the Flatplanner

¢ You can save finalized documents back to STEP
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Overview of the STEP Menu in InDesign

o When the STEP'n'design plug-ins are installed in InDesign, a STEP menu is added to InDesign's menu bar.
The STEP menu gives you access to specific STEP'n'design functions and enables you to perform arange
of operations on the active InDesign page.

e The STEP Palettes (also known as panels) are used for actual mounting of STEP data, including template
composition and image mounting. The STEP Palettes consist of five different tabs: STEP Structure View,
STEP Template Palette, STEP Images, STEP Tasks, and STEP Publication View. The tabs are used like
other InDesign panels.

e The STEP'n'design plug-in is described in detail in the STEP'n'design User Guide.

Mounting Planned Pages

This section provides information about mounting planned pages and finalizing pages in InDesign when working
with STEP Flatplanner. It also contains a description of how to update planned pages and how to use a workflow
when using STEP Flatplanner.

This topic assumes the following:

« Products have already been linked to planned pages in the Flatplanner
« You have already logged into the relevant STEP system from InDesign using the STEP'n'design plugin

Note: Before mounting your pages, make sure that you are working in the correct publication version. The
current version is displayed at the bottom of the STEP Publication View panel (e.g., 'Spring Wedding Catalog /
English US"). For information on how to change your current version, see Working With Version Layers in the
STEP'n'design documentation.

Mounting Planned Pages Using a Stored Publication Template
If using a publication template already stored in STEP, there is no need to have an InDesign document already
open to mount your pages. In fact, there is no need to even have the templates saved on your local machine.

Follow these steps to mount a planned page in InDesign by using documents stored in STEP and not on your local
computer.

Note: When using this method, you should mount the left side of a spread first (the even-numbered page), then
the right side (odd-numbered) next.

1. InInDesign, navigate to the STEP Publication View panel by navigating to Window > STEP Publication View
from the InDesign application bar across the top of the InDesign interface.

2. Inthe STEP Publication View panel, navigate to the even-numbered page that you would like to mount, then
right-click and select Create document from plan. (You can also access Create document from plan by
clicking on the options dropdown menu in the upper right corner of the STEP Publication View panel.)
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In a few moments (depending on your system's speed), the InDesign page will generate in the background,
then automatically open with the mounted Flatplanner content. This page (the even-numbered one) will be a

single page.

. Tomount the second page in the spread, right-click on the next page (the odd-numbered page) in the STEP

Publication View, then click Mount planned page.
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In a few moments (depending on your system's speed), the second InDesign page in the spread will generate
in the background, then automatically open as the right page of the spread, complete with its mounted

Flatplanner content.
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6. Make additional changes to the document as needed. These changes could include adding standalone
graphics, manually manipulating the layout of objects, or even dragging and dropping additional elements onto
the page fromthe STEP Structure View or STEP Images panels.

7. Save the document locally, then save itinto STEP. (See the Saving the Mounted Spread to STEP section
later in this topic for instructions.)

Mounting Planned Pages Using a Mounting Page

Even though a publication template is required to be stored in STEP in order to create publications and generate
proof views, designers will often choose to build pages using a document called a mounting page. A mounting
page is not generated using STEP'n'design, nor is it saved into STEP. However, it functions like a publication
template in that it contains all the paragraph styles, swatches, background elements, etc., that would typically be
included on a publication template.

Note: If you would like to mount metadata (description) attribute values from a publication, section, or planned
page object onto your InDesign page, the associated STEP'n'design tagging must be present on the publication
template and/or page template(s) that are stored in STEP and linked to your publication. This information cannot
be mounted to the InDesign page using a mounting page alone.

Follow these steps to mount a planned page in InDesign by using a mounting page that is saved on your local
machine:
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. With your mounting page open in InDesign, navigate to the STEP Publication View panel by navigating to
Window > STEP Publication View from the InDesign application bar across the top of the InDesign interface.

2. Inthe STEP Publication View panel, navigate to the page that you would like to mount.

3. Select the InDesign page (left or right side of your mounting page) onto which you would like to mount the

Flatplan.

. Right-click your page in the STEP Publication View panel and select Mount on current page. (You can also
access Mount on current page by clicking on the options dropdown menu in the upper right corner of the
STEP Publication View panel.)

Note: If the Flatplan mounts on the incorrect page, navigate to the Pages panel in InDesign (Window >
Pages) to ensure that the correct InDesign page is selected.

44 X

§| §| §| EI % STEF Fublication View =
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4 @ Flatplanner Publications
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111

[» {8 Hair Accy I Mount on current page
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. Follow the same steps for the other side of your spread.

. Make additional changes to the document as needed. These changes could include adding standalone
graphics, manually manipulating the layout of objects, or even dragging and dropping additional elements onto
the page fromthe STEP Structure View or STEP Images panels.

. Save the document locally, then save it into STEP. (See the Saving the Mounted Spread to STEP section
later in this topic for instructions.)
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Mounting Planned Pages Using a STEP Workflow

Typically, Flatplanner workflows have built-in functionality that automatically mounts Planned Pages using an
InDesign server, which is linked to the STEP application server as a sidecar. When InDesign pages are
automatically built by an InDesign server, the workflow tasks performed by DTP users of Flatplanner workflows
involve opening pre-mounted pages and making layout adjustments to them before saving back to STEP.

For more information on how to open pre-mounted pages in InDesign in conjunction with the Flatplanner
workflow, as well as save these pages back to STEP once completed with the workflow task, see the About
Flatplanner Workflows section of the Flatplanner documentation.

Saving Mounted Planned Pages to STEP

Once your planned page has been mounted in InDesign and all necessary changes have been made on the page,
the typical next step is to save it back to STEP.

Though it is optional to save mounted InDesign documents back to STEP, these documents must existin STEP in
order to take full advantage of STEP's publishing capabilities, such as extraction of product indexes and
calculation of space usage.

To save a mounted InDesign document back to STEP, follow these steps:

1. With your mounted document open in InDesign, first save it to your local computer.

Note: InDesign documents must first be saved locally before they can be saved to STEP.

2. Next, navigate to STEP > Save Document to DB from the STEP menu (which appears in the InDesign
application bar across the top of the InDesign interface). The Save Document to STEP Database dialog box
displays. The section folder from which you mounted your planned page should be automatically selected. (If
not, navigate to the correct section.)
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3. Fromthe dropdown list, select Save Document and Page Information (default) or Save Page
Information.

Choose Save Document and Page Information to save page information (such as page numbers and
space allocation) into STEP as well as the actual InDesign page itself. This option stores these documents in
the database for you and other users to access later.

Select Save Page Information if you would only like to save page information into STEP. This option will save
a thumbnail of your page to STEP but not the actual InDesign page itself. Some users may prefer this option in
order to save space on their STEP application server.

4. Check Close document and delete local copy if you would like to save the document to STEP, then have
the local copy automatically deleted from your computer.

5. Click OK. The document is saved back to STEP within the correct publication.

Note: Once mounted pages from a Flatplan are saved back into STEP, the frames on the Flatplanner page (in
the Plan view) now display 'Keep Layout' instead of the name of the product template that was previously applied
to the frame. If the planned page is mounted again, the layout from the saved actual page will be used instead of
the layout from the original product template. For more information about layout rules and reusing saved layouts,
see Reusing Saved Layouts in the Flatplanner documentation.
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Viewing Mounted Actual Pages in STEP

Mounted InDesign pages that are saved back to STEP are linked back to their original Flatplans through
hyperlinks and can be viewed in multiple locations in STEP. The linking that exists between actual pages and
Flatplans enables easy toggling between the original plan and the actual page.

The following list shows how actual pages, once saved back to STEP, are linked to Flatplans:

1. Inthe Flatplanner, hyperlinked page numbers appear in the upper left- and right-hand corners in all Views
(Plan, Preview, Sticker Book, and Mounted Pages).
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B+-(@ Party Favors

--ﬁ Cards & Stationery Streamers

£H-[E@ Decorations 16 | 22 2 |17
12 - Tablecloths

L T

1 14 - Ribbons B

{77 16 - Streamers IMI w [Chrizmas Pary Hz [Casmic Party Hat

=-E DTP Documents

10 - Napkins

. 12 - Confetti

=& i Streamers
] 16

- [E0 Cake Toppers [Streamers - Muli | | [Steamers - Purpld |Pink & Green Party | [Pink & Green Pom-
+-[@8 Hair Accessories

+-[@8 Drinkware

+ @8 Napkins

@ Halloween Catalog

#-@ Christmas Catalog

#- [l New Publication [Keep Layout ]| |[Keep Layout |
- @ Acme Party Supplies

- WebUIPublicationTypes

0 TemnwehtFunicotons ™ || I

1 [ »

[Keep Layout || [[Keep Layout | [Keep Layout || [[Keep Layout |

11

E
£
E
£

[Keep Layout || [[Keep Layour ]

2. Click one of these hyperlinked page numbers to go to the Page data tab of the actual page. Click the page
hyperlink below the actual page thumbnail to return to the Flatplan.
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Tree < 16 - Page data =
{7 Web Sites - RELENGETEN | Details || Motes || References || Status
Il Entity Root —
- GDSN ¥ Description
-0 GDSM Receiver Name >| > [value .
-[@) Promotions > ID 166979
ﬁ Publications > [Name 16
(&) Templates —
ﬁ Standard Publications * |Created Mon Apr 04 15:30:39 EDT 2016
ﬁ Autopage Publications > |Status Assigned
E}ﬁ atplanner Publications » |Pagenumber 16
=@ Spring Wedding Catalog
-6 Commercial Data > ffs Overset e
[#-E@ March Exclusives § Products
@@ Party Favors D > > |Name » |Space Used > |Page Type >
%R Cards & Stationery > 110046 Streamers - Purple [3862.23 mm? Actual
[=-[E@ Decorations
fF 12 - Tablecloths | _ | | [* [110049 Streamers - Blue & |4153.85 mm?2 Actual
{315 14 - Ribbons “Il|> 10050 Streamers - Hanging3862.24 mmz2 Actual
16 - Streamers > 110047 Streamers - Multi  [3862.23 mm2  Actual
=) DTP Documents
10 - Napkins P Classifications
12 - Confetti | |ID >| > |Name > |Space Used >|Page Type >
EI-- 16 - Streamers
2 iE % Images
17 D *| > |Name ’
#-[E8 Cake Toppers * 110051 Streamers - Blue & Orange

3. With the actual page document selected in the Tree, hyperlinks to the Flatplan appear beneath the thumbnails
of the actual pages on the Pages tab.

“ <16 - Streamers rev.2.1 - Pages -
Autopage Publications = ||| Document m Refererces || Status

=) Flatplanner Publications

=@ Spring Wedding Catalog
6165 Commercial Data

(@ March Exclusives

B8 Party Favors

- Cards & Stationery

R Decorations o
{30 12 - Tablecloths
ifZ]E] 14 - Ribbons

ﬁ 16 - Streamers | —

=& 0TP Documents

10 - Napkins
12 - Confetti
BE

#-E@ Cake Toppers

(-8 Hair Accessories

[-[@8 Drinkware v
« | i | »

Saving Empty Mounted Pages Back to STEP

Pages in Flatplanner spreads must sometimes be left empty in order to allow space for content outside of STEP.
Examples of content that designers may add from outside of STEP include full-page graphics or advertisements.

A spread with an empty page is saved back to STEP in the same fashion as if both pages in the spread contained
content.
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Sometimes, however, an Error warning (outlined in the below screenshot) will appear when saving back an
empty page. This typically happens if the empty page was manually added to the spread in InDesign (or was
already present in the mounting page) and was not mounted from an empty Flatplan (i.e. a Flatplan that contains
frames but has no linked products).

Save Document to STEP Database
Structure Point

|+ [ Party Favors
[+ [l Cards 8 Stationeny

Fering Wedding Catalag [ [E8 Cake Toppers
g [» (@B Hair Accessories
-] [» (@B Drinkware
E [» (@B Napkins
E ) V3 Halloween Catalog

[ [l Chrstmas Catalog -
V3 Mew Publication
[ Acme Party Supplies

111

[ B webLIPublicationTypes
[ B TempwebLTPublications
[» [T Primany Product Hierarchy -
1 | Page  Plan path State
14 Spring Wedding Catslog/Decorations/1...  OK k.
I 15 Errar (W]
" o
e Save Document and Page information -

|:| Close document and delete local copy

[ ok ][ Ccancel |

If you receive this error and ignore it, your empty actual page will be saved back to STEP but there will be no
hyperlinks connecting it to the Flatplan, as pictured below:

Tree €16 - Streamers rev.2.1 - Pages &
& Flatplanner Publications » || Document M References || Status

=@ Spring Wedding Catalog | &= —
-6 Commercial Data g---

[-@@ March Exclusives
[-E@ Party Favors T .
(@ Cards & Stationery
EH-[E8 Decorations

ﬁ 12 - Tablecloths
ifZ]E] 14 - Ribbons
ﬁ 16 - Streamers _—
=& DTP Documents I

111

1

-l 12 - Confetti
=) 16 - Streamers

+-[E8 Cake Toppers

-8 Hair Accessories % I =

4 I 2 -

© Stibo Systems - Confidential 83



StiboSystems

If you receive this error and would like to have your empty actual page linked to a Flatplan in STEP, follow these

steps:

1. Click on the ellipsis button next to the Error status (outlined with a red frame in the first screenshot in this

section). A Choose Plan dialog displays.

page, then click OK.

Choose Plan

# [ M3 EXOUSIVES

[+ [l Party Favors
[» ([l Cards & Stationeny

[l Decorations
-
[GER
-
[EE1s-
.-

Tahbledoths
Tahbledoths
Ribbons
Ribbons

Streamens

[+ (B8 Cske Toppers
[» [l Hair Accessories
[» ([l Drinkware
[+ (Bl Mapkins
[ Hallowieen Catalog
[» [l Cheistmas Catzlog
[» New Publication
[» Acme Party Supplies
[» [ WebUIPublicationTypes
[ [ TempWebUIPublications

[ oK

) |

Cancel

)

111

1

In the Choose Plan dialog, navigate to the Flatplan (planned page) to which you would like to link your actual

3. The empty actual page is saved to STEP and contains a hyperlink to the selected Flatplan.
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€16 - Streamers re... ™
-l Autopage Publications + ||| references | status
Nt ]

-[& Flatplanner Publications |
=@ Spring Wedding Catalog

6t-f5) Commercial Data ==
&[0 March Exclusives B w
B[ Party Favors i

&[0 Cards & Stationery | _ i
EH-[E@ Decorations

----- & 17 - (110703)

if3]F] 12 - Tablecloths

£33 14 - Ribbons [ 36 ]

if3JF] 16 - Streamers =

=) bTP Documents
w-E 12 - Confetti ‘ ‘

Dacume

-- 16 - Streamers
t- (80 Cake Toppers
t- @8 Hair Accessories
t @8 Drinkware
- @8 Napkins

- @ Halloween Catalog ﬁ
- @ Christmas Catalog

Opening Mounted Flatplanner Pages in InDesign

£
[
£
[

If changes need to be made to mounted pages after they are initially saved in STEP, they should be opened from
within InDesign, not from your local computer.

When a page in STEP is opened from within InDesign and edited, saving this page back to STEP from within
InDesign will overwrite the page that was previously saved. If you make edits to a page from your local machine
instead, then save that document back to STEP, a new document will be created in STEP and this document will
not be linked to the original Flatplan.

To open mounted Flatplanner pages from the STEP Publication View panel, follow these steps:

1. InInDesign, open the STEP Publication View by navigating to Window > STEP Publication View from the
InDesign application bar across the top of the InDesign interface.

2. Next, make sure that you are working in the correct publication version in InDesign. Your publication version
will be displayed at the bottom of the STEP Publication View palette; for example, Spring Wedding Catalog /
English US.
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V3 ﬁTempla‘bE -
[ B Standard Publications
[ B Autopage Publications
~ ﬁ Flatplznner Publications
= [l Sering Wedding Catalog
[+ [l March Exchisives
[+ [l Party Favors
[+ [l Cards & Stationeny

111

[l Decorations
[ 12 - Tableckoths
[ 13 - Tableckths
[ 14 - Ribbons

Bs-r

- Streamers
B 17 - Steamess
[» [l Cake Toppers
[ (B Hair Accessories -

StiboSystems

If the displayed version does not match the publication that you are working with, navigate to STEP > Change

Version to change to the correct version.
E [Ex] IIJIJE-’:'l i MW~

Connect to DB ...
Reload

Update Document Data ...
Layer Version Update ...
Check DB Update ...
Cleanup Mount Tags

Preferences ...

Change Version ...
Table Settings ...

Save Document to DB ...
Writeback to DB ...
Dump Document Data ...
Relink Assets
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In the Change Version dialog that displays, select the correct publication version, then click OK.

Change Version

[ ﬁTempla‘nE
[+ [ Standard Publications
[» [0 Avtopage Publications
< (B Flatplanner Publications
[l Spring Wedding Catslog
[EgEnslizh UK
[EEnslzh Us
EgFrench FR
[ Hallowieen Catalog
b [l Chvismas Cataieg
[ Mews Publication
[ Acme Party Supplies
[» A WebUIPublicationTypes
[+ [ TempWebUTPublications

ok ]|

Cancel |

Inthe STEP Publication View, navigate to the Flatplan for the page that you would like to open. With the

page object selected, right-click and select Open actual page.

| 57| 57| ST| 57| ¢ STEP Publication View

e
= B0 Flatplanner Publications
= [l Sering Wedding Catalog
[+ [l March Exchisives
[ (@B Party Favors
[ [E Cards & Stationery

= [l Decorations
[ 12 - Tableckoths
[ 13 - Tableckoths
[ 14 - Ribbons
[ 15 - Ribbons

s 16 -
Bl? - Sreamens
[+ [l Cake Toppers

111

URL..
Create document from plan

I Open actual page I

v Scroll to page
Refresh
Show
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6. The mounted page that was saved back to STEP will open. If the page was saved as part of a spread, both
pages in the spread will open.

7. Make any changes to the page as needed, then save it back to STEP by following the same steps outlined in
the first section of this topic.

Updating Documents in Flatplanner

After a document has been saved back to STEP it is possible to update page cells from the STEP Publication
View.

Note: If a page needs to be updated, then a 'not equal' symbol #is shown in the Preview area of the STEP
Publication View.

1. Click the relevant page in the Preview area of the STEP Publication View.

bse W
s ]

....... ¥

= [l Fatch £50-b

w [E5 Section 1

D‘El - Page &

(510 - Page 10

(511 -Page 10

[E12 - Page 12 |

Patch 220-8 [ English version

2. Expand the Options menu, and then click Update page cell(s).
The page cell is updated.
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Using the getinheritedPublicationValue Function in Flatplanner

The calculated attribute function 'getinheritedPublicationValue' is used to pick up metadata (Description) attribute
values from section, publication, and publication group objects. Use cases for this function include the display of
publication-related metadata on mounted product objects, in Flatplanner Sticker Book views, and on Flatplanner
planned pages.

When valid for Flatplanner planned pages, calculated attributes using the 'getinheritedPublicationValue' function
can be used to mount publication metadata onto InDesign pages by way of InDesign tagging applied to the
publication template. This functionality allows users more dynamic control over content that exists as 'furniture'
(publication template elements) on page spreads. For example, a section-level description attribute that identifies
the 'theme' of the Section could be displayed on side tabs or headers of mounted pages, reducing manual work on
publication templates and mounted pages.

The following steps describe how to use the 'getinheritedPublicationValue' function to pull metadata values from a
section, a publication, and a publication group onto an InDesign page mounted from a Flatplanner planned page.

Configuring the Calculated Attribute(s)

1. Create a calculated Description attribute using the 'getinheritedPublicationValue' calculated attribute function
by following these steps:

« After creating the attribute, right-click in the Value template field on the Attribute tab and select Edit
Function. The Function Editor will open.
« Click Insert Template, then expand the Publishing Functions section of the Default Templates.

« Select 'Find an attribute value in the publishing (green) hierarchy' and click OK. The Insert Template
window will close.

« Inthe Function Editor, replace ‘Attributeld’ with the ID of the metadata attribute that you would like to pull
onto the page.
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P "

E] Insert Template @

Description

Return the value of an attribute from within the publishing
hierarchy - looking up the hierarchy until a value is found

[=-Default Templates
--Cnndiﬁnnal Functions
--Text Functions
--.ﬁ.ttribute Value Functions
--Number Functions
--List Functions
--F‘.Eﬁarence Functions
--Hieran:hy Functions
--.ﬁ.II Functions
E--Publishing Functions

é----Find the first page number in the section Template

E""Find the last page number in the section getInheritedPublicationvalue Attributeld’)
i-Find an attribute value for an offer in a location

E----Find the value of a commerdal list and breakpoint in a location

..... Find an attribute value in the publishing (areen) hierarchy |

--Get the publication of the current page or section.

1 | 1] 3

[ oK H Cancel

2. Make the attribute valid on Planned Page objects by following these steps:
« Under System Setup, navigate to Basic Object Types > Planned Page

« Onthe Object Type tab, click Add Attribute, then select the calculated attribute(s) that you would like to
place on your publication template. In this example, three calculated attributes have been created: one to
pick up values from Section objects (ID = GetlnheritedSectionValue ), one to pick up values from publication
objects (ID = GetlnheritedPublicationValue), and one to pick up values from publication group objects (ID =
GetlnheritedPubGroupValue).
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P‘Ianned Page - Object Type

Object Type |ReFerences Log

@ Desaipton
Mame | » |Value
* D Planned Page
* MName Flanned Page
* Last edited by 2015-09-23 09:40:44 by USER.
* MName Pattern
> [D Pattern [id]
* con
* Dimension Dependencies
» Get Inherited Pub Group Valu £ #Acme Party Supplies - Since 1305
» Get Inherited Publication Valy £ SPring Wedding 2016
» Get Inherited Section Value | & MN/A
@ valdatrbutes
D * |MName
* GetInheritedSectionValue Get Inherited Section Value
* [GetInheritedPublicationValue Get Inherited Publication Value
» EeﬂnheﬁtedPuberpValue et Inherited Pub Group Value

1 Add Attribute I
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« GetlnheritedSectionValue [using the formula getinheritedPublicationValue('SectionTheme')] will pick up
the value of the description attribute SectionTheme:
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Publication Section [ Plan ” Publication Planner
& Descript

Mame » | > |value
*> 1D 108202
* Mame Party Favors
Ohject Type Section
» Revision 0.1 Last edited by Lt
» Path Publications Flatplan
» Gtart section on page 1
» Circulation 123
» Cover Photo Shot Due & 2015-0%-17
» Effective Date En|
» Expiration Date x|
» Mail Date (same as Effective |

Section Theme

abi

Party Favors

W

Total Mumber of Ttems

123

StiboSystems

GetlnheritedPublicationValue [using the formula getinheritedPublicationValue('CatalogTheme')] will

pick up the value of the description attribute CatalogTheme:

[ Plan ” Version " Pages ” Publication Planner ]
® Descripti

Mame *| » |Value
* D 108199
» Name Spring Wedding Catalog
Ohbject Type Publication
» Revision 0.5 Last edited by USER. on Wec
» Path PublicationsFlatplanner Publicat

W

Pages per spread

2

W

Auto page Document Level

1

W

Publication template

Wedding Pub Temp (109967)

* Dutput engine InDesign
> DTP Queue

Catalog Theme abe SPring Wedding 20156
» Circulation 122

GetlnheritedPubGroupValue[using the formula getinheritedPublicationValue('CatalogGroupTheme')]

will pick up the value of the description attribute CatalogGroupTheme:
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eubication crow [[FERY
® Descripti

Mame | > |Value
* 1D 103193
» MName Flatplanner Publications

Object Type Publication group types
» Revision 0.1 Last edited by USER on Wed Sep
» Path Publications,Flatplanner Publications
* Unit " inches

Catalog Group Theme sbe JACE Party Supplies - Since 1905 I
* Circulation 123

3. Navigate to a Planned Page object to confirm that the values are displaying correctly.

"i Entity Root - [m] Planned Page [m[m State Log m

Elﬁ Publications

—_— ﬁ Templates ¥ " o> Val

= ﬁ Standard Publications ame i

§| ﬁ Autopage Publications * D 108309
— E}ﬁ Flatplanner Publications * Name Confetti

- < B Spri :

L - @ Spring Wedding Catalog > Revision 0.3 Last edited by USER on Wed Sep
@ % Commerdial Data — —

@ 21 Party Favors * Path Publications,Flatplanner Publications
[ =] B -

g £ | He=fassliumber 3

@ : 6 - Napkins » (zet Inherited Pub Group Valu £ Acme Party Supplies - Since 1905
] =] OTP Documents - -

a = » (Get Inherited Publication Valy £ SPring Wedding 2016

o [+ 55 Glassware

m [+ [§li| Cards & Stationery > Get Inherited Section Value | & Party Favors

g [+ [E8 Decorations

Note: Calculated attributes related to publishing functions cannot be tested in the Function Editor, as

publication hierarchy [green] objects are not among the available options when selecting an object as the
Evaluation Node.

Configuring the Publication Template

1. Place the attributes on the publication template just as you would place attributes on a product template. Note:
attributes must be placed on the page spread, not the master spread.
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|<STEPR EF A="GetlnheritedPublicationvalue” /= =STEPREF A="GetInheritedPublicationvalue” .-’=|

ol ahid
=Y =¥
O o
- -y

] 11
< <
ke ke
kd hked
[~ [~ 4
[~ [~
kb kel
= -
W w
v v

ERE : <STEPREF A="GetinheritedPUbGronpvalue” /> <STEPREF A="GetinhieritedPubGrompvalue™ 7> SE

2. The publication description attribute values will display on the mounted page in InDesign and the Flatplanner
Preview view.
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Spring wedding 2016 Spring wedding 2016
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See the Calculated Attribute Functions Overview section of the System Setup / Super User documentation
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for general information on calculated attribute functions.

See the following sections of the STEP’n’design documentation for more information on building and configuring

publication templates and product templates:

« Publication Templates

o Product Templates

Generating PDFs

3

When you have planned your pages in the Publication Planner, you can generate PDF proofs of the planned
pages to ensure that they look the way you want them to.

You can also generate a PDF that only includes pages that have already been completed in InDesign and saved

back to STEP.
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1. Inthe Tree, expand the Publication hierarchy, and then select the relevant section or spread.

2. Onthe Plan tab, right-click in the white area of the page, and then choose Generate PDF. The Generate PDF

dialog appears.

Note: Clicking on either the left-hand page or the right-hand page will generate a PDF of both pages in the

spread.

|t

1
Set page template...

Layout

View

Generate PDF I

Print planned pages...

Add MNote....

Insert frames on a grid

3. Inthe PDF Profile list, select the preferred profile.

FE] Generate PDF I&1

POF Profile: Default -

Only actual pages: [

Delivery Plugin: Default PDF Delivery plugin -

[ Ok ” Cancel I

4. Ifyouwantthe PDF to only include pages that have been completed in InDesign and saved back to STEP,

check Only actual pages.
5. Click OK.

Note: PDF profiles are system dependent. Therefore, the PDF profile is set to Default if no special PDF profiles
have been configured for the system. Please contact Stibo Systems if you need additional PDF profiles.

Printing Planned Pages

You can print planned pages from the Promotion Planner.
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1. Inthe Tree, expand the publication hierarchy.
2. Click the relevant publication, expand the hierarchy and select the section or spread you want to print.

3. Onthe Plan tab, right-click the white area, and the choose Print planned pages. The print dialog appears.

[ E Print . @

Printer: ilgar-print1ICYOTE v

Page size: | a4 -

Orientation: |porirait - |

Print: @ Pages
| |
f (") Spreads
i Copies: i b

Pages: i@ Al

(") From: 2 To 5
||
[ Print ] [ Cancel

e S [

From the Printer list, select the relevant printer.
From the Page Size list, select the relevant page size.

From the Orientation list, select the relevant page orientation.

N o o B

Select Pages if you want to print a page on each page or select Spread if you want to print a spread on each
page.

8. Inthe Copies field, enter the number of copies you want to print.

9. Select All to print all pages or select From to define the range of pages you want to print.

10. Click Print.

About the Publication Planner
The Publication Planner is used to control the sections and pages of a publication. You can perform the following
tasks in the Publication Planner:

« Insert or remove pages and sections

Reorder the sequence of pages and sections

Apply page templates to pages

Start and stop workflows

View information related to the plan page or frame contents
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To View the Publication Planner

« Inthe Tree, select a publication or a section, and then click the Publication Planner tab.

Using the Publication Planner with Flatplanner Workflows

Using the Publication Planner with Flatplanner workflows is covered in the About Flatplanner Workflows
section of the Flatplanner documentation.

Configuring the Publication Planner Column View

The columns in the Publication Planner are configurable by using the Column View dropdown at the top of the
editor. The entries in the Column View dropdown are managed by the View Options drop down at the top right of
the editor. For more information about creating a customized view, see the Customized Views section of the
Flatplanner documentation.

Customized View Content

You can add or remove the following view content within the Publication Planner.

Content Description

Element

Assignee* Displays the current user assigned to the spread

DTP update Displays the result of a previously performed comparison between the data held on an
needed actual page for the planned spread and that active in the step database

Frame Displays the frame ID

Group by Adds a tree like control for each section and groups the planned pages under them.
section

ID Displays the ID of the first page in the spread.

Name Displays the name of the spread

Next Milestone Displays the next milestone date based on the milestone configuration and the workflow's
Date* next milestone.

Next Milestone | Displays the next milestone name as defined by the workflow business rule actions.
Name*

Page Attribute Displays the value of an attribute from the planned page (attribute is configurable).
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Description

Page note count

Display the number of notes applied to a page.

Page Number

Displays the page number of the planned page

Page Template

Displays the page template assigned to the plan

Plan to Actual
update needed

Indicates if the plan has been updated since the actual page was last worked on and saved
to the database.

Product

Displays the Product assigned to a frame.

Section name

Displays the name of the section

Status Displays the currently workflow state

Thumbnail Displays a thumbnail of the actual page if one has been produced for the plan
Traffic Light Displays the name of the attribute calculated as the milestone date color
Name*

*Requires a STEP Workflow component license. The columns Next Milestone Date, Next Milestone Name and
Traffic Light Name are colored according to the current date, milestone date and duration / color settings. For
more information about how to configure Milestones and Traffic lighting, see the Publication Milestones section
of the Flatplanner documentation. For general information on Flatplanner workflows, see About Flatplanner
Workflows in the Flatplanner documentation.

Sorting / Filtering

Right clicking on the Publication Planner column headers shows a menu that allows the contents to be sorted /
filtered and columns to be added / removed from the current view.

Publication Planner Actions

The Publication Planner supports the following actions by right clicking with one or more rows selected. Some of
the mentioned actions are described in more details later in this section.
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Action Description

Add Section in

Created a new section on specified level

Create new Section
from existing...

Creates a new section in the selected section by duplicating from another.

Add Pages Before Creates additional Flatplan pages

Selected Page

Add Pages After Creates additional Flatplan pages

Selected

Page/Section

Autonumber pages Renumbers the Flatplan pages

Set page template Sets the page template on the selected Flatplan pages

Remove pages

Deletes the selected spreads

View Plan

Changes the workbench view to show the selected Flatplan

Assign Pages™

Sets the merchandiser assigned to the pages (if workflow is not active for the pages)

Start Workflows*

Starts the workflow for the selected Flatplan pages

Stop Workflows*

Stops the workfow for the selected Flatplan pages

Return task to default

Releases a current task that has been claimed by a user to the default group

group assignment* assignment.
Go to workflow Go to the workflow process in the workflow tab.
process®

Create InDesign
Package from
flatplans

Initiates a process that creates an InDesign package for the Flatplans

Import InDesign
Package

Initiates a process that imports an InDesign package
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Action Description

Generate PDF Initiates a process that creates a PDF of the pages.

Check for update Initiates a process that compares the STEP data mounted onto the InDesign
needed... documents with that in the database and reports if a difference is found.

Update... Initiates a process that updates STEP data mounted onto the InDesign documents.
Update actual page Initiates a process that adjusts the actual pages for changes made to the Flatplan
with plan changes pages (e.g. product swapped between pages).

Copy table to Copies the data displayed in the publication planner so it can be pasted into a
clipboard for Excel spreadsheet for external purposes.

*Requires a STEP Workflow component license. For more information about how to work with the Flatplanner
workflow, see About Flatplanner Workflows in the Flatplanner documentation.

Changing the Page Order in the Publication Planner
You can reorder pages in the Publication Planner.

In the Tree, expand the publication hierarchy, and then click the relevant publication or section.
Click the Publication Planner tab.

Click the + sign next to the name of a section to view the pages of the section.

A wbd -

Click the row that contains the page that you want to move, and then hold down the left mouse button while you
drag and drop the page to its new position.

When a page is moved, the page numbers are automatically updated.

Changing the Page Template in the Publication Planner
In the Publication Planner, you can change the page templates that are used on the different pages.

Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.
Click the Publication Planner tab.

Click the + sign next to the name of a section to view the pages of the section.

A oD~

Select the row of the preferred page, right-click, and then choose Set Page Template. The Choose a Page
Template dialog appears.
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E Choose a Page Template ﬁ

Left Page Template ;Market Publishing Page Template -

Right Page Template |Market Publishing Page Template -

[ oK H Cancel ]

L

5. Fromthe Left Page Template list, select the preferred template. To use different templates on the left and
right, click the Padlock button to unlock it.

6. Click OK.

Inserting Pages in a Section in Publication Planner
You can use the Publication Planner to manage pages of a publication.

In the Tree, expand the publication hierarchy, and then click the relevant publication or section.
Click the Publication Planner tab.

Click the + sign next to the name of a section to view the pages of the section.

A wbd -

Right-click the row of the section where you want to add pages, then choose either Add Pages before
selected Page or Add Pages After Selected Page/Section.

[ Publication " Plan " Version " Pages ][ Financial Summary " AutoPage Publication Planner " Pagination Rules

Column View: | Default - Public -

Mssignees ¥ Thumbnail » Mame
» [-] Party Favors

> luser .. Canfath

I Add Section In »
Lser - a g [
§ i Create new Section from existing...
> _ ’ ! Add Pages before selected Page

Add Pages After Selected Page/Section

L
Ny

Autonumber Pages

» [¥ Glassware
» [+] Cards & Stationery Set page template
» [+] Decorations

» [+ Cake Toppers

» [+] Hair Accessories

Remove Pages

WYiew Plan

5. The New Pages dialog appears.
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FE] Mew Pages lﬁw

Pages

First pagenumber |4

Mumber of pages |2

Page Template s

Create H Cancel

6. Inthe Number of pages field, enter the number of pages you want to add.
7. Inthe Page Template dropdown list, select the template you would like to use for the new pages.
8. Click Create to insert the pages.

Inserting Sections in the Publication Planner
You can use the Publication Planner to manage the sections of a publication.

1. Inthe Tree, expand the publication hierarchy, and then click the relevant publication or section.
2. Clickthe Publication Planner tab.

3. Select a section, and then right-click the arrow [~] next to the section row. If you want to add a subsection to an
existing section, make sure that you have selected the preferred section.

Choose Add Section In, and then click either the publication or a section from the list. The New Section dialog
appears.
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E Mew Section ﬁ

Ohject Type

(7 5ub Section

-

Pages

Section ID 70256
Section Mame

First pagenumber | 16
Mumber of pages |2

Select page template
Page template | Use =

GetTerms\WsPageTemplate
Market Publishing Page T... |«
test

[ Create H Cancel ]

o 0N =

6.

Select whether you want to add a Section or Sub Section.

In the Section Name field, enter the name of the section.

In the First page number field, enter the page number that is the first page number of the new section.
Inthe Number of pages field, enter the number of pages you want the section to have.

In the Select page template area, click the Use field next to the template you want to use. A green check
mark appears next to the selected template.

Click Create to insert the section.

Removing Pages in the Publication Planner
You can use the Publication Planner to remove pages and sections from a publication.

1.

In the Tree, expand the publication hierarchy, and then click the relevant publication or section.

2. Click the Publication Planner tab.
3. Click the + sign next to the name of a section to view the contents of the section.
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4. Right-click a page, and then choose Remove Pages. If you want to remove multiple pages, hold down the
SHIFT key while you select the pages.

5. A warning message appears asking you to confirm the deletion. Click OK to confirm the deletion.

Exporting and Importing Flatplanner Publications in Excel

Two Excel formats are available for the export and import of Flatplans and Flatplanner publications: Flatplan
Excel and Publication Excel.

Using Excel sheets to export and import Flatplanner publications can help reduce the time spent on manual
publication-building tasks in the workbench, such as the manual drag and drop of products out of Flatplanner
baskets onto Flatplanner frames, or the manual linking of product templates to Flatplanner frames. If all product
and asset objects are already mapped to Flatplan frames on an importable Excel sheet, there is not even a need to
populate a Flatplanner basket.

The import of Flatplanner publications and Flatplans is suitable for users who prefer to plan their publications
before building out planned pages in STEP. For example, businesses that publish sales flyers may receive page
planning information from an upstream ERP system that predetermines item placement based on analysis of
historical pricing and sales data. In this use case, planning decisions do not need to happen in STEP; users can
skip directly to the DTP page building process once their Flatplanner publication is built in STEP with the import.

Even for users who prefer to manually plan and build their pages simultaneously in STEP, the ability to export and
import Flatplans and Flatplanner publications greatly simplifies the migration of publications from one STEP
system to another, reducing the number of manual steps needed to duplicate and/or rebuild these publications.

The following sections of this documentation explain the information included in the Flatplan Excel and
Publication Excel spreadsheets; the similarities and differences between the two formats; and where the
information on the sheets exists in STEP.

For step-by-step instructions on how to export a Publication Excel or Flatplan Excel spreadsheet from a
Flatplanner publication in STEP, see Exporting a Publication Excel Sheet in the STEP'n'design
documentation.

For information on Flatplan Excel and Publication Excel imports, see the Importing Flatplanner Publications in
Excel section of the Flatplanner documentation.

For more detailed information on Export Manager functionality and the Export Manager wizard, see Data Export
Manager Wizard section of the Export Manager documentation.

Getting Started with Flatplanner Excel Exports

The typical first step in using a Flatplan Excel or Publication Excel sheet to import a Flatplanner publication or
Flatplan is to export a pre-existing Flatplanner publication or Flatplan. This exported Excel file can then be used as
a 'template’ sheet to import new Flatplanner publications and Flatplans.

The Flatplan Excel format is only available for Flatplanner publications and supports the export of section-level
Flatplanner information, i.e., Flatplans. A Flatplan—also known as a plan—is composed of planned pages (also
known as spreads) and the product and/or asset objects that are linked to the Flatplan frames on these pages.
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Flatplan Excel sheets contain information about the page templates used on each page and the product templates
used on each frame. Additional frame-level information, such as X /Y coordinates and frame height and width, is
also included.

While the Flatplan Excel format is only available for Flatplanner publications, the Publication Excel format
supports all publication types: standard STEP'n'design (‘drag and drop'), Flatplanner, and AutoPage. When used
to export Flatplanner publications, additional columns with information specific to Flatplanner are included in the
sheet.

The Flatplan Excel and Publication Excel formats are nearly identical in structure and functionality, but with a few
notable differences. While the Flatplan Excel format only includes Section-level Plan information, the
Publication Excel format includes more in-depth information about the entire Flatplanner publication.

A Publication Excel sheet could later be used to build an entire Flatplanner publication on import, whereas the
Flatplan Excel must be used with an existing publication. The Publication Excel format also contains the
following Flatplanner information that is not present in a basic Flatplan Excel sheet:

« Publication-level information that could be used to later create an entire publication on import (e.g.,
Publication ID, Version ID, Publication Template ID, and Version ID)

« Publication hierarchy metadata (description) attribute IDs and attribute values
o Pagination rules

o Layer mapping configurations

« IDs and object types of Flatplanner basket contents

« Frame type information (i.e., galley or object)

¢ Free Text frame contents

Note: The Publication Excel format is only available when exporting from the publication level. It is not available
for exports from the publication group level or section level.

Sample Flatplanner Publication Excel Export Spreadsheet

The following screenshots show a sample Flatplanner Publication Excel export spreadsheet in three sections—
columnsA-1,J-R, and S - AG. Columns shaded light yellow appear in both the Publication Excel and Flatplan
Excel formats. Both formats allow only one object per row.
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A B & D E F G H |

1
2 213 Acme Party Supplies Default publication type 109967

=
z 121313 English U5 Context1 Main

£
6
7
8
9|
10
1]
2|
3]
14
15
16
7|
18
19 "121163
20 | Doc-dev page temp
21 4xd
22 I3

J K L M N 0 P Q R

1
2| <Action ID="PublicationTemplateSpreadindexAction” Ty
3| CatalogTheme Acme Party Supplies

4
5 121171 Product
6 121177 Product
T 121178 Product
8 121179 Product
9 121184 Product
10| 121192 Product
1] 121193 Product
12 ] "121180 Product
13| 121182 Product
14 121183 Product
15 121190 Product
16| 121218 Product
AT 121175 Product
18 121176 Product
19 121200 Asset
20
21
22
23
24|
25
26
21 21314 PatyHats  Section
28 | SectionTheme Party Hats
297 "21316  PatyHats  Section
30| SectionTheme Party Hats
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S T U v W X id z AA AB AC AD AE AF AG

1 PageNumber PageName PageTemplatelD  PagePickuplD MountObjectiD MountObjectType ProductTemplatelD FramelD X Y Width Height FrameType TextContent  AssignedUserlD
N Party Hats 121163
32 "21324 7917 08 725 B9 B0 Galley
33 121171 Product
34 "21177 Product
35 121190 Product
36 3 121163
7 "121324 6552 075 075 B3I W5 Galley
38 121193 Product
39 121178 Product
40 "21179 Product
41
42
43
44 Confetti Doc-dev page temp DTPUSER
45 "109954 Product "109964 200 M0 075 ™25 163  Object
46 109955 Product "109964 201 452 075 25 462 Object
a7 "21200 Asset 09964 202 M0 562 25 163 Object
48 09953 Product "09964 203 52 562 M25 63 Object
49 204 703 303 25 094 Object Fun for everyone!
505 Confetti Doc-dev page temp
51 "110049 Product 109964 200 075 075 25 163 Object
52 10047 Product "109964 201 125 075 ™25 462 Object
53 110046 Product "109964 202 75 H62 25 463 Object
54 "110050 Product 09964 203 125 5e2 25 463 Object
133 Mapkins 121073 DTPUSER
56 "109954 Product 121073 200 M0 075 ™25 163  Object
57 09955 Product "21073 201 152 075 25 162 Object
58 109951 Product 121073 202 M0 562 25 163 Object
59 09953 Product "21073 203 152 B62 ™25 463 Object

Contents of Flatplanner Publication Excel Exports

The following table outlines the contents of both Excel formats available for Flatplanner Publication Excel
exports—Publication Excel and Flatplan Excel—in the order that the columns appear:

Column Header Description Publication Flatplan
Excel Excel

PublicationID STEP ID of exported publication X
PublicationName STEP Name of exported publication X
PublicationType Object type ID of exported publication X
PublicationTemplatelD STEP ID of publication template linked to the exported X

publication
PubPageTemplatelD STEP ID of page template(s) linked to the exported X

publication
VersionID STEP ID of the publication version(s) of the exported X

publication
VersionName STEP Name of the publication version(s) of the X

exported publication
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Column Header

Description

Publication Flatplan
Excel Excel

VersionContext|D

STEP ID of the context(s) used in the publication
version(s) of the exported publication

VersionWorkspacelD

STEP ID of the workspace(s) used in the publication
version(s) of the exported publication

SectionLevel A number that represents whether the section is a top-
level section (1) or a subsection (2, 3, 4, etc.)

SectionlD STEP ID of the exported publication section(s)

SectionName STEP Name of the exported publication section(s)

SectionTypelD

Object type ID of the exported publication section(s)

MetaDataAttributelD

STEP ID of metadata (description) attributes linked to
the publication or section (column will not appear in the
export if there are no values populated for the metadata
attributes)

MetaDataAttributeValue

Value of metadata (description) attributes linked to the
publication or section (column will not appear in the
export if there are no values populated for the metadata
attributes)

RuleSettings

Pagination rules used in the publication(s) and sections

Example: <Action
ID="PublicationTemplateSpreadindexAction"
Type="PublicationTemplateSpreadindexAction"
parametertemplateSpreadindex="1"> <Condition
ID="AlwaysCondition" /> </Action>

BasketObjectID

STEP ID of the product(s) and/or asset(s) linked into the
Flatplanner Basket

BasketObjectType

Value will either be 'Product' or 'Asset’ depending on
whether a product object or an asset object is linked to
the Flatplanner Basket. 'Product' and 'Asset' are generic
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Column Header Description Publication Flatplan

Excel Excel

terms and do not specify the exact object types of the
products or assets.

PageNumber

Page number of the planned page

PageName

STEP Name of the planned page

PageTemplatelD

STEP ID of the page template linked to the planned
page

PagePickuplD

STEP ID of the actual page that was picked up as the
layout for the planned page

MountObjectID STEP ID of the product or asset object linked to the
Flatplanner frame
MountObjectType Value will either be 'Product’ or 'Asset' depending on

whether a product object or an asset object is linked to
the Flatplanner frame. 'Object’ and 'Asset' are generic
terms and do not specify the exact object types of the
products or assets.

ProductTemplatelD

« Inthe Publication Excel format, this column
contains the STEP ID(s) of the product template(s)
linked to the exported publication and each
individual Flatplan frame

« Inthe Flatplan Excel format, this column only
contains the STEP ID(s) of the product template(s)
linked to each individual Flatplan frame

FramelD STEP ID of the Flatplanner frame

X X coordinate of the Flatplanner frame on the planned
page

Y Y coordinate of the Flatplanner frame on the planned

page
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Column Header Description Publication Flatplan

Excel Excel
Width Width of the Flatplanner frame X X
Height Height of the Flatplanner frame X X
FrameType Value will either be 'Object’ or 'Galley', depending on X

whether the Flatplanner frame contains a product,
asset, or free text ('Object’) or is a Galley text frame

(‘Galley")
TextContent Free text content of the Flatplanner frame X
AssignedUserID STEP user who is currently assigned the planned page X X

in the Flatplanner workflow

Location of Flatplanner Publication Export Information in STEP
The following sections use a sample Flatplanner publication to illustrate where the information included in
Flatplanner Publication Excel and Flatplan Excel exports resides in the STEP Workbench.

Publication Tab

1. The PublicationID and PublicationName columns will contain the STEP ID and STEP Name of the
publication, respectively.

2. The PublicationType column will contain the object type ID of the publication.
3. The PublicationTemplatelD column will contain the STEP ID of the publication template.

4. The MetaDataAttributelD and MetaDataAttributeValue columns will contain the STEP ID(s) and STEP
Names(s) of populated metadata attributes that appear on the publication and section(s). Note thatifa
publication (or section) has linked metadata attributes but these attributes do not contain values, the
MetaDataAttributelD and MetaDataAttributeValue columns will not appear on the exported sheet.

5. The ProductTemplatelD column will contain the STEP ID(s) of the product template(s).
6. The PubPageTemplatelD column will contain the STEP ID(s) of the page template(s).

7. The LayerMappingTemplate column will contain the name of the layer in the templates (publication, product,
and InDesign-created page templates); LayerMappingDocument will contain the name of the corresponding
layer in the Publication Document (mounting page); and LayerMappingOwner will display whether the
publication version to which the layer is mapped is the owner of the layer—value of 'true’ or 'false.' In the
following screenshot, 'English US' (displayed in bold) is the owner of the 'Images' layer.

Note: When exporting a 'model' Flatplanner publication in order to use the resulting publication Excel sheet as a
template for later Flatplanner publication imports, it is recommended to populate at least one metadata attribute
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on the publication (and each section) with a 'dummy’ value. This ensures that the MetaDataAttributelD and
MetaDataAttributeValue columns appear on the 'template' sheet and will not have to be manually inserted later.
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Acme Party Supplies - Publication

AutoPage Publication Planner || Pagination Rules || Page Inspeckor || Status || Stake Log || Tasks

[ Flan ” Version ” Pages " Publication Planner ” Plan Maokes ” Financial Summary
Descripton
| U@e »

121311

Acme Party Supplies

Fublication

.1Last eai y USER on Fri Mov 13 16:44:05 EST 2015
* Path PublicationsFlatplanner Publications fAcme Party Supplies
* Pages per spread 2
* \Auto page Document Level 1
Pt oot @) =
> DUTpUT engine T InDesan
> DTP Queue

* Mail Date (same as Effective |[E
* Total Mumber of Ttems 123

» Effective Date E

> iration Date

* Catalog Theme abe Acme Party Supplies
» Circulation 123

* Cover Photo Shot Due &

Doc-Dev_PRODUCT Template_GALLEY
|> Party Product Template @
* Main Product Template
emplate
@ PageTemplates
Mame * Default >
> dxd
1= 6
* Doc-Dev_PAGE Template_GALLEY {
> [2x2
> |Add template
T e —
Template # |Document * \Versions >
> France France o French FR
» Images Images English US; French FR; English UK
*USA US4 English US
> UK LK English UK
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Version Tab

1. The VersionID column will contain the STEP ID(s) of the publication version(s).
2. The VersionName column will contain the STEP Name(s) of the publication version(s).

3. The VersionContextID column will contain the STEP ID(s) of the context(s) to which each publication version
is linked. (Note: The context name is displayed in the workbench.)

4. The VersionWorkspacelD column will contain the STEP ID of the workspace to which each publication
version is linked (will either be 'Main' or 'Approved').

< Acme Party Supplies - Version o

Page Inspector || Status || State Log || Tasks

[ Pages ” Publication Planner H Plan Motes ” Financial Summary l

AutoPage Publication Planner
| Publication H Flan ]

7 Version Description

Paqgination Rules

ID > |Name * |Context * Workspace > |Availak
* 1181250 o English UK 9 English UK 9 Main e
» 121313 English US English US Main
* 1181251 French FR French FR Main
* | Add version

Sections and Planned Pages

1. The SectionLevel column will contain a number that represents whether the section is a top-level section (1)
or a subsection (2, 3, 4, etc.).

2. The PageNumber and PageName columns will contain the page number and name of planned pages.

3. The SectionID, SectionName, and SectionTypelD columns will contain the STEP IDs, STEP Name, and
STEP object type of all sections and subsections.

EI Acme Party Supplies

i % Commerdal Data [ Plan ” Publication Plar
E} (E8 Party Hats? @ Description
=- i Party H Mame *| » |Value
2 - Party Hats - B
[#-L]] . DTF Documents
. OTP Documents I MName 9 Party Hats
EI i Party Favars Object Type Section
-~ 4 - C“”F‘Eb > Revision 0.1Last edited
ﬁ & - Napkin —
B2 DTP Documents * Path Publications,Fla

Plan Tab — Basket
1. The BasketObjectID column will contain the STEP ID of the objects linked into the Flatplanner Basket
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2. The BasketObjectType column will contain 'Product' or 'Asset' depending on whether a product object or an
asset object is linked to the Flatplanner Basket.

Publication

Acme Party Supplies - Plan

AutoPage Publication Planner || Pagination Rules || Page Inspector || Status || State Log || Tasks

m[ Version " Pages "

Basket maintained locally

Publication Planner "

Plan Motes

" Financial Summary l

Column View: | Default - Public -l
D 0 > Mame » PrimaryProductImage * On Pages
f ‘
121182 ™ Blue Wizard Baloon Hat e,
121183 N Pink & Blue Giraffe Party Hat %
121190 N Dog Party Hats Assortment :&ﬁﬂ 7
121218 W pink & Blue Owl Party Hat
121175 ﬁ Mardi Gras Mask - Green i
121176 8 Vardi Gras Mask - Gold A2l 7
121200 ' Pog Party Hats Assortment :&ﬁm 7 i
I

<

T

Plan Tab — Page Information

1.

N o o A

The PageTemplatelD column will contain the STEP ID of the page template used on the Flatplan page.

(Note: The page template name is displayed in the Plan view in the Workbench.)

The MountObjectID column will contain the STEP ID of the object linked to the Flatplanner frame. (Note: The
object name is displayed in the Plan view in the Workbench.)

The ProductTemplatelD column will contain the STEP ID of the product template linked to the Flatplanner
frame. (Note: the product template name is displayed in the Plan view in the workbench.)

The FramelD column will contain the STEP ID of the Flatplanner frame.

The X and Y columns will contain the X and Y coordinates of the Flatplanner frame.

The Width and Height columns will contain the dimensions of the Flatplanner frame.

the TextContent frame will contain the content of Free Text frames.
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1@@0

Confetti

@) | Bzmord Corfers

9 [T : Party Product Template

Red Heart Co

=
200 201
I
5 Hanems =
a Frame ID: | 201
k ¥ pos: 4,52 inches
f pos: 0,75 inches
Width: 3.25inches
Fun for evenyonsa!
ey Height: 4.62 inches
Layer:
| T : Party Produ

202

-

8. The MountObjectType column will contain 'Product’ or 'Asset' depending on whether a product object (left) or
an asset object (right) is linked to the Flatplanner frame.

[Bhee Wizard Baloon Hay

[T : Party Product Template

[ i Ma template assigned
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9. The PagePickuplD column will contain the STEP ID of the Actual Page that was picked up as the layout for
the planned page. (Note: The link to the actual page is displayed in the tooltip text in the Plan view.)

Napkins

=]

I
Page pickup from: /Flatplanner Publications/5Spring Wedding Catalog/Party Favors/2 - Confettif2|

[Diamond Gonferdufeti ferti ‘ ‘ & W=

10. The FrameType column will contain either 'Object' or 'Galley' depending on whether a standard page template
(blue frames) or Galley page template (green frames) is used on the page. Pictured below is a Galley page
template as viewed in the Plan view.

Galley Page
4  Doc-Dev_PAGE Template_GALLEY Doc-Dev_PAGE Template_GALLEY 5

Publication Planner Tab
The AssignedUserID column will display the User who has been assigned the page in the Flatplanner workflow.

© Stibo Systems - Confidential 118



Publication || Plan || Version || Pages |BETHGELGGEZENGTT [ Plan Mo

Default

Colurmn View:

ssignee
ts
>

Party Hats/Party Hats

e 3 A

> | dihs,

* Thumbnail

| e -

- 128

> IMNfA

Pagination Rules Tab

StiboSystems

STEPXML code for Pagination Rules linked to the publication and/or sections will be included in the
RuleSettings column. The screenshot below shows a pagination rule set at the top level of the publication. Note
that if a publication has no pagination rules, the RuleSettings column will not appear on the exported sheet.

Note: When exporting a 'model’ publication in order to use the resulting Publication Excel sheet as a template for
later publication imports, it is recommended to manually set up the desired pagination rules first. This ensures that
the RuleSettings column appears on the 'template' sheet and will not have to be manually inserted later.

Acme Party Supplies - Pagination Rules

Importing Flatplanner Publications in Excel

AutoPage Publication Planner |BRERLEMGHIN N [ Page Inspector || Status || State Log || Tasks
Publication " Plan ] Wersion [ Publication Planner ” Plan Mokes " Financial Summary ]
7 Object Layout
(Condition » [Action » Defined At »
X Default condition Ize product template Party Product Template  JAcme Party Supplies
Add Rule
2 Set publication template spread index
(Condition » |Action * Defined At >
X Default condition Set publication template spread index 1 Acme Party Supplies
Add Rule
[ Add Rule Group

Entire Flatplanner publications can be created or updated with the import of a Publication Excel spreadsheet.
For existing Flatplanner publications, the Flatplan Excel format can be used to create or update sections and

Flatplans, which are the planned pages (spreads) within the sections.
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The typical first step in importing a Flatplanner publication and/or Flatplan is to export a pre-existing Flatplanner
publication. The resulting Publication Excel or Flatplan Excel file can then be used as a 'template’ sheet for new
Flatplanner publications or Flatplans, i.e., existing information on the export sheet will be replaced with new
information for the subsequent import.

For more information on exporting Flatplanner publications in either Excel format, see the Getting Started with
Flatplanner Excel Exports section of the Flatplanner documentation.

Importing a Flatplanner Publication Excel Sheet

The steps to import or update a Flatplanner publication using a Publication Excel sheet are nearly identical to
those of importing a Publication Excel for any other publication type, with the exception of the additional
Flatplanner-specific columns needed for Flatplanner publications.

While some fields may be left blank on the Publication Excel sheet to successfully create a new Flatplanner
publication (e.g., PublicationName, MetaDataAttributelD, and RuleSettings) all Flatplanner-specific fields on the
Publication Excel sheet must be filled out if your intention is to update an existing Flatplanner publication. If you
want to create a new Flatplanner publication or Flatplan—and you have configured the STEP IDs to autogenerate
for your publication, section, and version object types—then the ID fields for these object types should be left
blank.

For step-by-step Publication Excel import instructions, see the Importing a Publication Excel Sheet section
of the STEP'n'design documentation.

Importing a Flatplan Excel Sheet

Flatplan Excel sheets can be imported either at the publication or section level. The following screenshots show a
sample Flatplan Excel spreadsheet that could be used to create two sections and nine pages of a Flatplanner
publication.

A B C D E F G H | J K L M N
1 SectionlD SectionName SectionTypelD PageMumber PageMame PageTemplatelD MountObjectiD  MountObjectType ProduciTemplatelD FramelD X Y Width Height AssignedUserlD
2 Party Hats NEW  Section 2 Party Hats 21163
3 3 121163
4 i Galley Page "21163
5 5 "21163
6 Party Favors NEW  Section ] Confetti Doc-dev page temp 09954 Product 21385 200 "0 75 ™25 ™63 DTPUSER
7 109955 Product f121385 201 "4.52 .75 "25 62
8 109951 Product "109964 7202 .0 562 ".25  "W63
9 109953 Product 09964 7203 "4.52 562 "325 463
10 204 "3.03 7303 "256 D94
1 5 Confett Doc-devpagetemp 110049 Product "109964 "200 075 75 25 63
12 110047 Product 09964 201 "4.25 75 25 M2
13 110046 Product 109964 202 .75 562 "325 463
14 110050 Product 109964 203 26 562 "25 463
15 B MNapking 1109954 Product 200 1.0 75 ™25 63 USER
16 109955 Product 201 "4.52 .75 "25 62
17 109951 Product 202 ".0 562 "3.25 463
18 "109953 Product 203 .52 562 "325  "M63
19 204 "3.24 20 256 D94
20 T Napkins Doc-dev page temp "21176 Product "109964 201 7428 075 28 463
21 "121200 Asset 7202 0.75 562 'BAg 463
22 121178 Product "09964 UpperLeft .75 .75 "338 "63
23 B Children’s Party Hats ~ Doc-dev page temp 21177 Product 21385 201 7438 075 M3 4e2
24 "121178 Product "121385 7202 .85 562 .28 463
25 121179 Product 21385 7203 "4.38 562 "33 463
26 121171 Product f121385 UpperLeft .85 .78 "28 63
27 ] Doc-devpagetemp 21205 Asset 201 138 075 "28 63
28 f21218 Product 21385 202 .75 562 "338 "63
29 121183 Product 121385 7203 "4.38 562 "328 463
0 "21182 Product "121385 UpperLeft 076 076 "33  "463

Steps to Import a Flatplan Excel Sheet

1. Right-click on the publication or section object into which you would like to import your sheet. Select Import
Plan.
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ﬁ Publications ‘
- 50 Templates
Iﬁ Standard Publications Mew Publication Section...
-l Autopage Publications
Ellﬁ Flatplaniner Publication
EI Spring Wedding C. I Import Plan... I
-5 Commerdial D Link product
-- Party Favors Link azzet
[+ [ER Cards & Static
-- Decorations
.. Cake Toppers Update plan from actual page...
-- Hair Accessor

*

ER Create new Section from existing...

Reapply page template(s)...

[+ [ Crinkware Cut
- [l Halloween Catalo Copy
-l Christmas Catalog Paste
[+ B WebUIPublicationType )
lﬁ i Paste Link

-0 TempWebUIPublicatio

2. The Select Excel File dialog will appear. Navigate to your Flatplan Excel import sheet and click Open.

3. The Save Import Configuration dialog will appear. Click OK. (Though you have the option to save your
import configuration on this screen, there is no real need to do so, as no mapping is required for a Flatplan
Excel import.)

4. The import process will begin automatically. Click Go to process on the Starting process Importing dialog
if you would like to monitor the import Background Process as the Plan imports.

Considerations and Limitations

« Flatplan Excel files cannot be imported using File > Import > Data. Flatplan Excel sheets must be imported
by a right-click action on either publication or section objects.

« Frame sizes and X/Y coordinates cannot be altered with Publication Excel or Flatplan Excel imports. Frame
sizes will remain the same size as specified by the page template that is linked to the page.

For More Information

For more information on the fields contained in both the Publication Excel and Flatplan Excel sheets for
Flatplanner publications, see the Contents of Flatplanner Publication Excel Exports section of the
Flatplanner documentation.

For more information on mandatory and required fields on Publication Excel import sheets, see Importing
Publications in Excel in the STEP'n'design documentation.

For more detailed information on Import Manager functionality and the Import Manager wizard, see Overview of
the Data Import Manager Wizard in the Import Manager documentation.
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Creating Financial Reports

To analyze the data that is available in the Financial Summary view, you can create an Excel-based Financial
Report. You can create the report from two places in the publication hierarchy—the publication level and the
section level.

To Create a Financial Report

1. Inthe Tree, expand the publication hierarchy. Right-click the relevant publication or section, and then choose
Financial Report. The Financial Reports dialog appears.

P o)

m Financial Report @

Column View: | Default - Public -
Show summary for: ‘Actual pages i w
Section Levels: 3 -

| Include product/classification information

¥ | Include page information

’ Ok H Cancel

2. Fromthe Column View list, select the preferred column view. The available views correspond to the views
that are available in Financial Summary view.

3. Fromthe Show summary for list, select either Basket, Planned pages or Actual pages.

+ Basket provides the data from Basket view
o Actual pages provides the data for DTP pages that have been saved back to STEP.

« Planned pages provides the data for the planned pages. If available, space usage data is extracted from
the actual pages.

4. From the Section Levels list, select the number of levels you want to include in the report. The level is relative
to the level you have clicked in the Tree.

Example: If you have selected a publication node in the tree, the publication is level 1, the version is level 2,
and the section is level 3.

5. Toinclude product names, check Include product information.
6. To view the financial data per page, check Include page information.

7. Click OK. Excel opens and displays the report.

© Stibo Systems - Confidential 122



StiboSystems

Space Usage in Financial Reports

Space usage provides information about how much space a product presentation takes up on a page. This
information is useful, for example, to analyze sales per square inch or millimeter for a product. This in turn helps
you decide how much space to give a product in the next catalog or where to place the product.

Toinclude space usage information in a financial report, do the following.

« Verify that space usage handles the white space of a product presentation the way you want it to.
o Add a Space Usage column to Financial Summary view.

« Add a Calculation column to Financial Summary view if you want to use space usage in a calculated
attribute.

Space Usage Setup
The standard space usage setup calculates the space usage for a product presentation based on the raw data on
a page. It does not include the white space of the product presentation in the calculation.

For example, if you increase the font size of a product title, the space usage increases. However, if you increase
the size of a frame without increasing the size of the content of the space, the space usage does notincrease.
To Include White Space in Space Usage Calculations

If you want to include the white space of a product presentation in the calculation as well, you have to set this up in
System Setup.

1. In Systems Setup, click Users and Group.
2. Onthe System Settings tab, locate the Flatplanner Default Settings area.
3. Clickthe Value field of Enable calculation of border rectangle space usage for actual page.

@ Merchandiser Default Settings

Mame | Value b

= |Enable keep layouts for publications Ui

= |Enable calculation of border rectangle space usage for actual pages [N

The space usage now includes the white space of a product presentation from the upper left corner of the product
presentation to the lower right corner.

Note: You can only change this setting if you are a member of the Super User group.

Add Space Usage to Financial Summary View

If you want a financial report to include space usage information, you have to add the column Space Usage to the
Financial Summary view.

1. Inthe Tree, expand the Publication hierarchy, select a section or spread.

2. Onthe plan tab, click the Financial Summary tab.
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3. Inthe upper right corner, click View Options, and then choose Edit. The Edit View dialog displays a list of the
current view content elements.

4. Click an element, right-click, point to Add, and then choose Space Usage. If Space Usage is not listed, click
Other ....

5. Click OK.

Using Space Usage in Calculated Attributes.

If you want to calculate, for example, revenue per square inch or millimeter, you have to add a Calculation column
to your Financial Summary view. You can then include the information in the Financial Report.

—

. Complete steps 1-3 as described in Add Space Usage to Financial Summary View.

N

Click an element, right-click, point to Add, and then choose Calculation. If Calculation is not listed, click Other
.... The Add Calculation dialog is displayed.

« Inthe Name field, enter a name for the calculation.

« Inthe Formula field, click the ellipsis button (...), and then specify the preferred formula.

For detailed information about calculations and how to specify functions, see Calculated Attributes and Function
Editor in the Attributes section of the System Setup guide.

About Flatplanner Workflows

A STEP Flatplanner workflow links together all of the tasks involved in the process of planning and approving the
pages that comprise Flatplanner publications.

Unlike other STEP workflows, the Flatplanner workflow is integrated with InDesign through the STEP'n' design
plugin. This integration allows DTP (desktop publishing) users (also referred to as designers) to accept
Flatplanner workflow tasks from within InDesign without ever having to log into the workbench.

STEP Flatplanner workflows typically involve tasks such as planning pages, approving planned pages, routing
planned pages to designers who carry out layout tasks in InDesign, and approving finalized pages. The object type
that moves through a Flatplanner workflow is the Planned Page.

Configuring a Flatplanner Workflow

Instructions on how to configure specific elements of a Flatplanner workflow that are unique to the Flatplanner
workflow are covered in the Configuring Flatplanner Workflows section of the Flatplanner documentation.
These unique elements include the configuration of the STEP Tasks dialogs in InDesign as well as the options
available in the Publication Planner.

Sample Flatplanner Workflow

A sample Flatplanner workflow, which details the tasks involved in accepting tasks, planning a page, and
approving a page, is detailed in the Flatplanner Workflow Example section of the Flatplanner documentation.

As with any STEP workflow, Flatplanner workflows are customized according to specific customer requirements.
This is merely a 'how to' example that serves as a walkthrough of a simple Flatplanner workflow.
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Publication and Section Object Workflows
Workflows for publication and publication section objects may also be implemented in addition to a Flatplanner
workflow.

Publication and section workflows enable the assignment of tasks such as:

o Importing prices

« Publication planning, where information such as dates and styles are defined
« Linking of products to sections

« Population of metadata attributes on publication and section objects

Unlike Flatplanner page spread workflows (which require use of the Publication Planner), publication and section
workflows function like standard STEP workflows used for classifications, products, and assets. Also, a
Flatplanner license is not required to use a publication or section workflow. However, even with a Flatplanner
license, DTP users cannot pick up tasks related to publication and section objects in InDesign.

Note: Publication objects and section objects cannot share the same workflow. Each object type must have its
own standalone workflow.

Publication and section workflows are created by the same methods as any other workflow in STEP. For
instructions, see the Getting Started with STEP Workflows section of the STEP Workflows documentation.

Configuring Flatplanner Workflows

A Flatplanner workflow is built and configured like any other workflow in STEP, though it has a few features that
are unique to it, such as:

« The ability to send planned pages through a workflow
« The ability to stop and start workflows from the Publication Planner
« The ability to color-code workflow states in the Publication Planner

« The ability to set milestone / 'traffic light' colors in the Publication Planner, to give users a visual indicator of
how far along a Planned Page is in a particular state (see Publication Milestones in the Flatplanner
documentation for more information)

« The ability for desktop publishing (DTP) users to pick up workflow tasks in InDesign when changes need to
be made on actual pages

« Automated generation of InDesign pages using a background process, enabling DTP users to pick up
mounted InDesign pages in InDesign as part of the Flatplanner workflow process without having to manually
mount the pages themselves

The available options for a Flatplanner workflow will vary depending on how the workflow has been configured
and will vary from user to user.

General workflow topics such as configuring workflow states, transitions, views, etc., are not covered in this topic,
as they are not unique to the Flatplanner workflow.
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Note: If you are using a Flatplanner workflow for the first time on a STEP system that is version 8.0 or higher, the
following property must be added to the sharedconfig.properties file on your application server:
Workflow.FlatPlanner.SelfContained=true. Foruserswho have upgradedto STEP 8.0 but
need to continue using an existing (pre-STEP 8.0) Flatplanner workflow, this property should either be omitted
from the sharedconfig.properties file altogether or set to false. Contact Stibo Systems if you need assistance with
this configuration.

Creating the Workflow

A Flatplanner workflow is created by the same method as any other workflow in STEP. For instructions, see the
Getting Started with STEP Workflows section of the STEP Workflows documentation.

Flatplanner workflows must be made valid for the Planned Page object type.

Note: Only one object type is available in STEP for Planned Pages. Additional Planned Page object types cannot
be created.

< Flatplanner Workflow - Validit “put

STEP Workflow Editor Log || Status

= yalid for Attribute Types

= valid for Classification Types

= valid for Entity Types

= valid for List of Values Types

= valid for Asset Types

©-valid for Product Types

&~ yialid for Publication T

% Valid for Publication Flanned Page Types

All

==Valid for Publication Section Types

In addition, at least one state must be configured for use by DTP users in InDesign. See Configuring DTP Task
Views for InDesign in the Flatplanner documentation for more information.

Configuring Status / Workflow State Colors

In Flatplanner workflows, workflow states can be configured with color coding that displays in the
Publication Planner, on planned pages, and on actual pages. This color coding gives workbench users a quick
way to obtain an overview of which states each planned page is currently in.

The following screenshot shows how these state colors display in the Publication Planner.

Note: If the Status column is not visible in your Publication Planner view, it must be added. See the
Configuring the Publication Planner Column View section of the Flatplanner documentation for more
information.
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Publication Section ” Plan ] Publication Planner [ Plan Motes “ Financial Summary ]
Column View: |pefault - View Options
Thumbnail * [Name » |Page Number etaty i) * |Assignee
1=
> . Napkins 42, 43 Review (EN) 35477 Super user
> B 44, 45 35062 Super user
> . 46, 47 DTP (EN) 1359495 Super user
a [ 48, 49 ASSRE : 300+ N/A

Each status may be assigned a custom color. These status colors are configured by adding an RGB value to an
On Entry business action for each state that should receive a color code. This is achieved by setting the value of a
workflow variable called STATE_COLOR in the following business rule:

node.getWorkflowInstance (workflow) .setSimpleVariable ("STATE COLOR",
"217,241,253");

In this example, 217,241,253 is the RGB value of the light blue Review state shown in the previous screenshot.

Note: The Assigned status cannot be assigned a color by this method, since it is not a workflow state. If you
require a different color for the Assigned status, contact Stibo Systems.

Configuring State Color Business Actions
To configure the business rules that set status colors, follow these steps:

1. Locate the Flatplanner workflow in System Setup that you would like to edit, then right click and select Edit
STEP Workflow. The STEP Workflow Designer displays.

2. Inthe Workflow Variables/Attachments area, click the Add icon and select Add Workflow Variable.
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4.

5.

File Edit View
Workflow Properties

D FPusingGroup

Mame |Flatplan group assignment

Workflow Variables/Attachments

B SIS

Validation err

E] STEP Workflow Designer - FPusingGroup*

Flatplan group assignme

Add Workflow Attachment
Add Workflow Variable

R
B GP-ount Doc ForPlarg (1)

F‘Ian_l.';!wanges Bup

bgp.sugceeded

| I k Review ({1

StiboSystems

In the Add Workflow Variable dialog that displays, enter the ID STATE_COLOR, then click OK. The

variable is created.

£23 Add Workflow Variable ==
1D STATE_COLOR
Aftribute B
Expression
[ OK ] [ Cancel

Next, in the STEP Workflow Designer, double click on the workflow state for which you would like to specify
a state color. The State Editor dialog displays.

In the State Editor, navigate to the On Entry tab and click Add new Business Action, then click on the Edit
Operation icon on the Operations tab.
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E] State Editor
Edit

=%

T\ﬂUI Screen Mapping I

Mandatory Attributes

State|§ Entry§| On Exit | Assigneel Deadline/Escalation | Comments
Business Rule (Local business rule to be save|...| |El
Name
Description
Type Action
Scope Local
Run as privileged [ |
Opeggtions | Dependencieslhpplies if]
NARRES

Merge into

Add new Business Action

[ Show Edited State

StiboSystems

In the Edit Operation dialog that displays, click the dropdown list in the upper left-hand corner and select
Execute Javascript. The Execute Javascript options now display in the Edit Operation dialog.

E] Edit Operation

Ex5

[ | Execute Javasoipt ;]

Binds: ? Binds
Variable name

3|

9 Messages

Variable name

3|

Messages:

* |Binds to

> |Message

* |Translations

Javascript: |

Edit externally

< | 1

[ Save H Cancel

7. Click the 'edit' icon under the Binds flipper. The Edit Binds dialog displays.
8. Click the green plus sign Add Bind icon. Type node in the Variable name field, then select Current Object

10.

from the Binds to dropdown list.

Click the green plus sign Add Bind icon again. Type workflow in the Variable name field, then select
Workflow > Current Workflow from the Binds to dropdown list.

Your Edit Binds dialog should now look like the following screenshot. When finished, click OK to close the

dialog.

© Stibo Systems - Confidential

129



StiboSystems

-

E23 Edit Operation &3
I | Execute Jzvasonipt ;]
Binds: @ Binds
[\Variable name > |Binds to
vessages: T £¥] Edit Binds =5
IW Variable name Binds to Parameters
node [Current Object -
Javascript:
P workflow [Current Workflow -
Add Bind
Edit externall
4
[ OK ] [ Cancel ]
|

11. Inthe JavaScript field, copy and paste the following code:

node.getWorkflowInstance (workflow) .setSimpleVariable ("STATE COLOR",

"217,241,253");

E’ Edit Operation

[ | Execute Javasonpt q

Binds: ? Binds

Variable name

Binds to

node

Current Object

workflow

Current Workflow

S|

Messages: 7 Messages

[variable name » |Message

» Translations

=

JavaScript: | node . getWorks lowInstance (workflow) .setSimpleVariable ("STLTE_COLOR™,

PBilY, 281,883

Edit externally

Save Cancel

12. To customize the RGB value, replace the three numeric values with the RGB values of the preferred color.

13. Click Save to close the Edit Operation dialog. The business action is configured.

Viewing State Colors in Locations Other Than the Publication Planner
State colors for Flatplanner workflows also appear in the workbench in the following locations:

« Below Planned Pages on the Plan tab:
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Planned Page

BNCEE

Flatplanner

|E”X ¥: IW: H: }Uiew:PIan v: ' ~

42

Napkins

T
|Red Heart Con [ [Pink Heart Co

1
|Sreamers - Bl | [Streamers - H

Reviews (EN}

« Below actual pages on the Pages tab:

<_42 - Nankins rev.4.0 - Pages

~[@ Promotions
~{g Publications
[l Templates
@) Standard Publications
[l Autopage Publications
=+l Flatplanner Publications
=@ Spring Wedding Catalog
G- Commercial Data
- @@ New March 7
[+ @8 Party Favors_1
--i Party Favors_2
[+-ER Cards & Stationery
- Decorations
[+ R Cake Toppers
- @ Hair Accessories
B @8 Drinkware
=@ Napkins

- @ Halloween Catalog

F

Document m References || Status

111

+ Below actual pages on the Page data tab:
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< 42 - Page data I

[-[ER Decorations ol -
; BERETER (| Details || Notes || References || Status
G- Cake Toppers
[ @@ Hair Accessories & Description
F-E8 Drinkware Name >| > |[value N
Elﬁ Napkins > o ——
ﬁﬂtz Napkins
B J) DTP Documents * S 42
- > Created Mop Mar 07 17:18:06 EST 2016
Status Review (EN)
= FPagenumber )
‘@ Halloween Catalog g
‘@ Christmas Catalog * |Is Overset No

« Below actual pages on the Details tab:

Tree 47 - Details
ﬁ Templates - Page data Motes || References || Status

&) Standard Publications
&+ I§8 Autopage Publications sikin Wedding Calalog
=8 ﬁ Flatplanner Publications P e S Erp——
=@ Spring Wedding Catalog
665 Commercial Data
- @@ New March 7
[+-ER Party Favors_1
B8 Party Favors_2 Sy et SR
[-E@ Cards & Stationery
& [@@ Decorations
[-E@ Cake Toppers
(@0 Hair Accessories
[ E@ Drinkware
E--ﬁ Mapkins

i ﬁ«u Mapkins

E| DTP Documents

»

= L

m

111

Ewcancrs Bluz & dringe Emeamers Hatglog

— ke i o gawt. I!: ke besrd g apr s i
Brozs b & awas deou Dizclu sl cwee sl
ot

- @ Halloween Catalog il
- Christmas Catalog

- @ New Publication N 4]| = E

| 1 | »

For More Information on RGB Values

Though RGB values must be entered manually in the JavaScript string to configure state / status colors, an Add
Color dialog exists in STEP that could be used as a guide when deciding on a color. This guide displays the
numeric values for RGB colors, which could be copied and pasted into the relevant area of the JavaScript string.
For information on how to access the Add Color dialog, see the Defining Table Colors in STEP section of the
STEP Tables documentation.
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£53 Add Color

Mame |Unnamed

SwatchesHSVIH: F’-EEH-_I'IYH

Color Code DIF1FD

Preview
n

D Sample Text Sample Text

| ok || cancel

Configuring DTP Task Views for InDesign

DTP users accept STEP Workflow tasks in InDesign from the STEP Tasks panel. This panel is also where DTP
users return these tasks (in the form of actual pages) back to STEP after completing work on the page.

[E 44 (Party
[ Publication:Hallo Show Details

Refresh

Goto In Structure View

Goto in Publication View
Open document
3fITasks Filter

_ Show Tasks for Current Publication Only

When DTP users click Accept Task from the STEP Tasks panel, an Accept Task dialog displays.
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Accept Task
DTP {en_UIS) - 50
In Flatplan group assignment process "Wedding Candy” started by on 30/03/16 06:30

Plezse process the pagefspre...
mments Please add background graphics to right page

¥ | Open document V| Goto in Publication View [ Accept | [ Cancel |

Enabling the Accept Task Action in the STEP Tasks Panel

To enable the Accept Task action in the STEP Tasks panel in InDesign, at least one Component column using
the DTPTaskInfoProvider component must be added to the View for the DTP workflow state. This is configured

as follows:

1. In System Setup, navigate to the desired Flatplanner workflow, then right click and select Edit STEP
Workflow. The STEP Workflow Designer displays.

2. Inthe STEP Workflow Designer, navigate to Edit > Edit Workbench Views and Mappings. The View
Editor displays.

3. Ifnoviews or mappings are already present, create them according to the steps outlined in the Views and
Mappings for Workflows section of the STEP Workflows documentation.

4. Rightclick the View for the DTP workflow state, then select Add Column > Component.

£33 view Editor
Edit

Editor | xmL

7 & view: DTP -
+ View: Wao Add Column * Attribute

- = Mapping : Attribute Group
5] Mapping : Move Down

& Mapping : Aspect

& Mapping : Delete Component

5. Select DTPTaskInfoProvider from the Component dropdown list, then insert the desired text (which you

would like the DTP operator to see) in the Title field. The following screenshot shows the standard
configuration for the required DTPTaskInfoProvider component column.
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£33 view Editor
Edit

Editor|xm

=5

=HE view: DTP

Compaonent

El® [Column:Please process the page/spread: (DTPTaskInfoProvider)]

- Aspect: id
4] Aspect: name
~ [ Column:Comments (DTPTaskInfoProvider)

= Vview: Workbench

Mapping : Entering planning->Warkbench
Mapping : Review->Workbench

Mapping : DTPPageWork->DTP

Mapping : HandleBGPError->Waorkbench

Title |Please process the page/spread:

\ Read Only

N\

[] Mandatory
Component iDTPTaskJnfoProvider

This column will not appear in the Workbench
View. When applicable the Variable value will be
send as Task info to a DTP system. The Variable
ID will be used for value-name and the column
Title will be description.

Variable

Adding Additional Fields to the Accept Task Dialog

To add additional fields to the Accept Task dialog in

InDesign, additional columns using the

DTPTaskinfoProvider component may be added to the View in conjunction with workflow Variables.

The following example shows the column configuration for a Comments field. It uses the DTPTaskInfoProvider

component in conjunction with a workflow variable called COMMENT:

£33 view Editor
Edit

Editor|xm

=

=HE& View: DTP

& Column:Please process the page/spread: (D1
4 Aspect: id

4] Aspect: name

g [Column:Comments (DTPTaskInfoProvider)] \
g Column:Comments (WorkflowVariable)
= Vview: Workbench

----- 15 Mapping : Entering planning->Warkbench

Component
Title

N\,

Cumponenti

Comments

[] Read only

[] Mandatory
DTPTaskInfoProvider

Mapping : Review->Workbench
Mapping : DTPPageWork->DTP
Mapping : HandleBGPError-=Workbench

This column will not appear in the Workbench
View. When applicable the Variable value will be
send as Task info to a DTP system. The Variable
ID will be used for value-name and the column
Title will be description.

Variable

1L

COMMENT

Here is how this Comments field appears in the Accept Task dialog in InDesign:
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Accept Task
DTP {en_US) - 50

In Flatplan group assignment process Wedding Candy” started by on 30003/16 05:30

Comments Please add background graphics to right page

[/] Open document

Goto in Publication View (

Accept

)

This same Comments field can also be viewed in the workbench and populated with content before DTP users
pick up the task in InDesign. This is accomplished by adding a Component column to the View of another

workflow state that is viewable in the workbench. This should be a state that the Planned Page passes through
before it is routed to InDesign.

In this example, the component is WorkflowVariable and the variable is COMMENT (the same variable used to
generate the Comments field in the Accept Task dialog). The following screenshot shows this configuration for a
sample View called "Workbench':

Edit

£33 view Editor

Editor | xmL

Sl

=& view: DTP

=+8 view: Workbench

~E® Column:Please process the page/spread: (D
~W2 Aspect: id

-7 Aspect: name

- [EE Column:Comments (DTFTaskInfoProvider)

-~ EE Column:Comments (Workflow\ariable)

- B Column:Preview (WorkflowFlannedPage)
-7 Aspect: name

~u) Aspect: id
- B Column:Claim [WorkflowTaskColumn)
- B [Column: Comments (WorkflowVariable)]

----- 15 Mapping : Entering planning->Workbench

- & Column:Notes (WorkflowNoteColumn)
Mapping : Review->Workbench

Mapping : DTPPageWork->DTP
Mapping : HandleBGPError->Workbench

1L »

Component

Title | Comments

[ ] Read only

[ | mandatory
Component :Workﬂow‘n.r'ariable

Variable COMMENT

Here is how this column looks in the workbench:
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STEP Workflow Items
Plan || Elanned Page || Plan Notes || References || Status || State Log || Tasks

Prewew > [Name * |Claim Comments *
= - B Please add background
it f—ﬁ graphics to right page
Wedding Candy  *» Wedding Candy (135991 &)
& g

Fields in the Task Completed Dialog

Any columns added to the Accept Task dialog in InDesign using the DTPTaskInfoProvider component also
appear in the Task Completed dialog (also accessed from the STEP Tasks panel in InDesign). The Task
Completed dialog displays when DTP users have completed working with the page in InDesign and return it to
STEP.

The following screenshot shows how the Comments 'column' looks in the Task Completed dialog. DTP users
may overwrite the incoming comments, which will display in the workbench when the page is returned to STEP:

Task Completed
DTP {en_US) - 50 - -
It Flrplar gootys amsgramnt: procem Wskling Carsly’ stmtad by on SWEGH1G Save Document and Page information -
i [ B Standard Publications .
Please proce=s the page/spre... - I3 ﬁ Autopage Publications

Ia:u--a—-_-.- Page is complete I = [ Flstplanner Publications E

< [B Spring Wedding Catzlog
= [l March Exchusives

b7 (135977) -

Mote:

Save document to STEP [ | Close and delete local copy [ Completed | [ Cancel |

STEP Workflow Items

LRI G DYRGEN BN | Plan || Planned Page || Plan Notes || References || Status || State Log || Tasks

Preview » [IName * |Claim Comments >
'd. — —
r -E ; Page is complete
Wedding Candy > Wedding Candy 135991 a2
ko A

Flatplanner Workflow Example

This topic serves as a 'how-to' primer for working with a sample Flatplanner workflow and illustrates some
common tasks that are performed as a Planned Page moves through the various workflow states. The example is
simple but is examined on a state-by-state basis to provide you with a working knowledge of how a Flatplanner
workflow actually functions, not just how to configure one.
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The following screenshot shows a very simple Flatplanner workflow configuration in the STEP Workflow
Designer. This is the example used in this tutorial.

£33 STEP Workflow Designer - FlatplannerWF @
File Edit View
Workflow Properties = Flatplanner\F (Flatplannerr) &

D FlatplannerwF
: -

Mame |FlatplannerWF

Workflow Variables/Attachme... Retry

'STATE_COLOR! ab: -
BGP-MountDecForPlan |1 HandleBGPErrar (1
Plan_Changes N
- — — - bgprfailed
B (%] &
Validation errors: hgp sudceedsd ManuaMouint

—~ [ pTPPagework ()
| Review (1)

OTR-rewoark

Accepted

=
Done (1)
I

This topic does not explain how to create or configure a Flatplanner workflow and assumes the following:

o The Flatplanner workflow is already created in STEP

(If not, refer to the Configuring Flatplanner Workflows section of the Flatplanner documentation for
more information)

o The Planned Page has already been initiated into the workflow

(If not, refer to the Starting and Stopping Flatplanner Workflows section of the Flatplanner
documentation for more information.)

Note: As with any STEP Workflow, individual user requirements will determine the exact configurations. This
sample merely illustrates some standard uses of Flatplanner workflows in general.

Planning the Page

The first state of our example workflow is named Entering Planning. The name that displays on the STEP
Workflow tab under Tasks is determined by locale. In this instance, the Entering Planning state is named
Planning (EN) since we are working with an English version of STEP.
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E] Localize State Mames and Events @
‘ State Names§| Events|
1D * Name * |Danish * [English * |Spanish * |French >

> PlanningTask Entering planning Planning (EM) Planning (SE) Planning (FR)

» BGP-MountDocForPlan

» Review Review (EM) Review (SE) Review (FR)

» Done Done (EM) Done (SE) Done (FR)

» DTPPageWork DTPPageWork DTP (EN) DTP (SE) DTF (FR)

» HandleBGPError

The typical task performed during this state is for a workbench user—for example, a merchandiser who
determines product placement in catalogs—to plan the Flatplan pages. The central task of planning a page
involves linking products into frames on a Flatplanner page spread (Planned Page). Page planning can be done
without using a Flatplanner workflow, but the workflow enables you to receive your page planning assignments as

tasks.

If you are a page planning user, follow these steps to plan a page in conjunction with our sample Flatplanner
workflow:

1. Todetermine if you have been assigned a page planning task, click the STEP Workflow tab, and then click the
Tasks tab.

2. Navigate to the relevant Flatplanner workflow, then click the Flipper icon ® to view the tasks for the workflow.

3. Inthe Tasks list, click the first state, Planning (EN), to view the pages that are in the Planning state. Unless the
task has been assigned directly to you, you will need to click on the 'Show all items' or 'Show all items assigned
to me or any group | am a member of' icon [outlined below in red frame] in order to view all available tasks to
your User Group.

4. To claim atask and make it unavailable to other users in your User Group, click on the Claim icon.

5. Inthe Preview column, click on the page spread that you would like to plan.

< STEP Workflow Items =

STEP Workflow

z Profile STEP Workflow Items |NUNlR=s]ily
=N O
T E @ FlatplannerWF 0 - Preview >[I > |Name > |Claim
= [
§| Tls P latplanner Workflow Party Hats >l 135953 Party Hats &)
m i o
@l — [Filter by Collection E]E Party Napkins >l @ 135962 Party Napkins | g7 0
& | Planning (EN) 3
B § HandleBGPError 0
Zl| & | Review (EN) 2
A2 4 T
3 |&) o (Em) 0 D
5 -
@ | @ Hat Workflow -

6. The planned page spread displays in the Flatplanner on the Plan tab. Plan your page, and then click the

Save icon *=in the toolbar to save the changes.
7. Click on the Tasks tab to navigate to the Tasks view.
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I STEFP Workflow Itermns ]m[ Planned Page ” Plan Motes “ References ” Status “ State Log [ Tasks ] 7

6 Flatplanner
. . i ;
E EEE - |-E”)( ¥ ‘W: H: |View Flan hd U
Party Mapkins
8 x2 22 9
Diamond Confert Ctreamens - Muki Gtar Confiett
[T : Wedding Preduct Terng | [[T : Wedding Product Ternp] [T Wedding Preduct Ternpl | |[T : Wedding Product Terng
[Streamers - Hanging] [Streamers - Blue 8 Orange]

[T : Wedding Product Temj [T+ Wedding Product Ternpl [T+ Wedding Product Ternpl | |[T : Wedding Product Terng

8. Onthe Tasks tab, click Submit to move the spread to the next workflow state. A Submit items dialog displays
where you can enter information about the page if you wish, but this is optional.

9. Click Submit Now. The page moves along to the next state in the workflow, a 'hidden' state named BGP-
MountDocForPlan.

Auto-generation of the Actual Page

In the BGP-MountDocForPlan state, a background process calls the InDesign server. The InDesign server then
generates (mounts) the actual pages based on the information linked to the Flatplanner page spread. When
completed, the InDesign server saves these actual pages into STEP.

Note: An InDesign server (sidecar) must be connected to your STEP system in order for this background process
to run. For more information on the deployment of an InDesign server, contact Stibo Systems.

Once the InDesign server saves the actual pages to STEP, the actual pages are routed to the Review state.

If the background process fails (for reasons that could include the InDesign server being offline), and the actual
pages are not generated by the InDesign server, then business rules may be put in place that will route the
planned pages into the DTPPageWork state in order for a DTP (Desktop Publishing) operator to manually mount
the Flatplan onto actual pages in InDesign.
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In a typical page reviewing state, you will look at the mounted actual pages to determine if the pages are OK as-is
or if they need additional layout work performed in InDesign.

1. Todetermine if you have been assigned a page reviewing task, follow steps 1 - 4 as outlined in the previous
section, except this time click on the Review (EN) state.

2. Inthe Preview column, click the page spread that you want to review.

STEP Workflow < STEP Workflow Items

Profile

®- Discontinued State
@ Entity Workflow

& FlatPlanner

@ FlatplannerTB

©= Flatplanner\WF

& Flatplanner Workflow

P

Filter by Collection
Planning (EN)
HandleBGPError
Review (EN)

DTP (EN)

@ Hat Workflow
@ tam Craatinn

Fs

2)ia)(e)?
E_

o wla M~

STEP Workflow Items |WUN M=l

Preview

» |ID

>

Name

# |Claim

v
T
. b

Goodie bags

=]

#

135414
]

Goodie bags

oJ

Napkins > -

ﬂ 135477

Napkins

oJ

4

I

:Accepte-d EN

- st |

3. The actual page displays in the Flatplanner on the Plan tab in the Mounted Pages view.
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Review (EM)

If you wish to generate a PDF of the actual page, right click anywhere on the displayed page and select
Generate PDF. The system will call the InDesign server and a PDF of the page will generate and open
automatically.

Mapkins
45
Sanrinng o Rlicey -0 -y
Fre Hin Corbl Faed Hean Cariard “wy
£
Fil =
o [=R
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s =
Set page template...
Layout
View

r i Generate PDF
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5. When you have finished reviewing the page, the following Submit options are available in our sample
workflow:

I

ccepted e~ subm |
Accepted EN

DTF EN
Plan Change EN

« Accepted EN: The page is approved and is sent to the Done state of the workflow, at which pointitis
removed from the workflow.

o DTP EN: The page needs some manual work performed on it by a DTP operator in InDesign. The page will
be sent to the DTPPageWork state [DTP (EN)], which is a state in which the task must be accepted in
InDesign.

« Plan Change EN: The Flatplan needs more planning work performed in the workbench. The page will be
returned to the Planning (EN) state.

Accepting a DTP Task in InDesign

If the page reviewer chose the DTP EN transition from the Review state in the workbench, the page is routed to
the DTPPageWork state [DTP (EN)] in our sample Flatplanner workflow. Tasks in the DTPPageWork state must
be accepted from within InDesign.

To accept a Flatplanner workflow task from within InDesign, follow these steps:

1. Open InDesign and log onto the relevant STEP system.

2. Navigate to Window > STEP Tasks. The STEP Tasks panel displays.

[

3. Clickthearrow ™ nextto the relevant publication to expand all tasks that are available for that publication.

44 X

STEP Stru{ STEF Tem| STEP Imag STEP Tasks | STEP Publl  -=

7 Publication:Spring Wedding Catalog (2/2) A

{## 2 (Goodie bags) - DTP (en_US)
[ 44 (Party Napkins) - DTP (en_US)
[» Publication:Halloween Catalog (1/1)

3/3Tasks

4. Right-click on the relevant page, then click Accept Task. The Accept Task dialog displays.
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S =
Comments:

Accept Task

{en_UIS) - 50

[] Open document

In Flatplanner Workflow process "Goodie bags' started by on 059/03/16 03:23

the pagelspre...

Goto in Publication View

(

Accept

) |

Cancel

J
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5. Click Accept to simultaneously open the document and the STEP Publication View panel, where the
accepted page will be highlighted.

Spring Wedding Catalog
Pink Heart Confetti
e
R
R & STE STE STE STE % STEP Publication View
L]
iy [ @R (135577} L
. i = Party Favors_2 1
: T —
- " [ Y
P [ - Goodie bags
W T R4 - Party Hats
s - Party Hats
FR6 - Conferti -
[
L

Spring Wedding Catalog / English US

Note that Open document and Goto in Publication view are checked by default in the Accept Task dialog.
Uncheck Open document if you would like to finish claiming the task but open the document later. Uncheck
Goto in Publication View if you do not want the STEP Publication View panel to automatically display when

the page is opened.

6. Once you have finished work on the pages, return to the STEP Tasks panel. Right-click the page that you
were just working on (which is distinguishable by no longer being in bold text), then click Task Completed.

The Task Completed dialog displays.
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Task Completed
DTP (en_US) - 50
In Flatplznner Workflow process "Goodie begs' started by on 05003/16 03:50

Mote: Page has been remounted with plan updates

Save document to STEP

|:|Clnse and delete local copy

Save Document and Page information -

} = Party Favors_2 -

[» Cands & Stationeny
[+ [l Decorations

[+ [E8 Cake Toppers

[» [l Hair Accessories

[» ([l Drinkware =

111

[ Completed | [ Cancel |

To save the finished document back to STEP (which is the most common action at this stage of the workflow),

check the Save document to STEP box, then click Completed. The Section folder where the actual pages
should be saved in STEP is highlighted automatically. Optionally, you may leave a comment in the Note field
(and/or Comments field, if present, depending on your workflow's configuration).

If you prefer to not save your documents locally and only save them in STEP, then check Close and delete

local copy before clicking Completed.

Note: The page must first be saved locally, regardless, before it can be saved back to STEP.

8. Inour sample workflow, the actual page will now be routed back to the Review state for final signoff by a page

reviewer (e.g., the merchandiser).

Canceling a DTP Task in InDesign

If, after you claim the task in InDesign, you determine that you need to release it back to your user group so
another user can claim it, you may cancel the task. To cancel the task, follow these steps:

1. Inthe STEP Tasks panel, right-click on the page and select Cancel Task. The Cancel Task dialog displays.

Cancel Task
DTP (en_US) - 50
In Flatplanner Waorkflow process "Goodie bags' started by on 0900316 04:51

[ Cancel Task | [ Cancel |

2. Click Cancel Task to reject the task, enabling another user from your group to claim it. The task will remain in
the STEP Tasks panel and return to bold text.
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If your workflow has been configured with a Comments variable, you may optionally leave a comment in this
field. For more instruction on how to configure the Tasks view in InDesign, see the Configuring Flatplanner
Workflows section of the Flatplanner documentation.

Final Review

When the InDesign page has been completed, or if it never needed to be updated in the first place, the page will be
in the Review state of our sample Flatplanner workflow. To complete the journey of the page, follow these steps:

1. Follow the same steps as outlined in the previous Reviewing the Actual Page section of this topic.

2. When happy with the page, select Accepted EN to route the page to the Done state. Typically, an on-entry
business rule action will be applied to the state to automatically remove the page from the workflow.

Ll

:Accepted EN v: Submit
Accepled EN

DTF EN
Plan Change EN

Starting and Stopping Flatplanner Workflows

Planned Pages (also known simply as pages or spreads) can be initiated into a Flatplanner workflow both
manually and automatically. By either method, planned pages can be initiated into a workflow on a one-at-a-time
basis or in bulk actions where multiple pages are initiated at once.

Pages can be initiated manually from both the Publication Planner and Tree, and automatically upon their
creation when the primary Flatplanner workflow is set to initiate automatically.

Planned Pages can be manually removed from a Flatplanner workflow from the same two locations where they
can be manually initiated: the Publication Planner and the Tree.

Starting the Workflow Manually

If your Flatplanner workflow has not been configured to initiate automatically, you will need to manually initiate
your Planned Pages into the workflow. Planned Pages can be initiated into a Flatplanner workflow from two
locations: the Publication Planner and the Tree.

Method 1 - Publication Planner
To manually initiate a Planned Page into a Flatplanner workflow from the Publication Planner, follow these steps:

1. Inthe Tree, expand the Publication hierarchy, and then select the relevant publication or section. The
Publication Planner is accessible from both locations.

2. Click on the Publication Planner tab.

3. Onthe Publication Planner tab, click the plus + sign next to the relevant section to view the Planned Pages
within the Section. If your Publication Planner view has not been configured with the 'Group by section' view
option, the Section name and + sign will not appear.
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4. Planned Pages that are not already in a workflow will show a status of Assigned in the Publication Planner.

Assigned means that the planned page will automatically be assigned to a User Group once the page is
initiated into the workflow.

Tree < Party Favors - Publication Planner =pt
""" [Z) GDSN Receiver data pools 4 ||| AutoPage Publication Planner inakig State Log || Tasks

B-[E) Promotions

ot Publication Section H Plan [ Plan Notes ] Financial Summary ]
&=+ Publications - :
ﬁ Templates Column View: | Default -
-6 Standard Publications - i
&8 Autopage Publications Thumbnail > [name > [Page Number [Status 6 >[I » [Assignee
& Flatplanner Publications Party Favors
. =@ christmas Catalog Import” * Party Hats 2,3 /A
E| @ Spring Wedding Catalog > Goodie bags 4,9 /A
: =N % Commercial Data t Confetti 6, 7 NfA
° ‘3 Party Favors > Candy 3, 9 MfA
-[#8 Cards & Stationery N Napkins 10, 11 N/A
: B Decorations t MNoisemakers 12, 13 M/ A
. R Cake Toppers

5. Select the Planned Page spread or spreads that you would like to initiate into a Flatplanner workflow. Spreads
may be multi-selected by holding Ctrl or Shift while making selections.

6. Right click and select Start Workflows. The Start Workflows dialog displays.

I Publication Section ” Plan ] Publication Planner Plan Motes “ F
Column View: .De-fault -
Thumbnail > [Name > |Page Number » [Status » D

* =l Party Favors

Goodie bags g 2,3, Assianed 135414 |
Party Hats 4,5 \ Add Section In v
Confetti 6,7 \ |# Create new Section from existing... B
Candy 89 \ Add Pages Before Selected Page L
Napkins 10, 11 \ Add Pages After Selected Page/Section -
Noisemakers 12,13

Autonumber Pages B

Set page template
Remove Pages

View Plan

Assign Pages
Start Workflows @
Stop Workflows

7. Inthe Start Workflows dialog, select the relevant workflow from the Workflow to start dropdown list, then
click OK. Optionally, you may enter a process note in the Process note field.
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E] Start Workflows @

D Workflow to start :EFIathanner Workflow! v:

Process note

[ OK H Cancel

8. The Planned Page is initiated into the initial state of the selected Flatplanner workflow.

I Publication Section H Plan l Publication Planner Plan Motes

Column Views: .Default

-

Thumbnail * Name * |Page Mumber Status * D
» =] Party Favors
> Bl Goodie bags 2,3 Planning (EN) 135414
g (| Party Hats 4,5 PSS 25412
> Bl Confetti 6, 7 HESiGREE | 35420
- EE Candy 8,9 ASSGRE 1 35424

Note: Once a Planned Page (spread) has been initiated into a Flatplanner workflow, it may not be initiated into
another Flatplanner workflow.

Method 2 - Tree

To manually initiate a Planned Page into a Flatplanner workflow from the Tree, follow these steps:

1. Inthe Tree, navigate to the Planned Page(s) that you would like to initiate into the workflow.

2. Right-click and select Initiate in STEP Workflow. Multiple Planned Page spreads may be chosen at once by
holding Ctrl or Shift while making selections.

& Flatplanner Publications

@@ Christmas Catalog Import Test
=@ Spring Wedding Catalog

ﬁ;ﬁ Commercial Data

@R Party Favors |
{1712 - Gondie hans

@  Initiate in STEP Workflow

: [ Remave from STEP Workflow
.ﬂ'_‘ o

T

{215 10 - Napkins
m 12 - Noisemakers
=l DTP Documents

3. Inthe Start Workflows dialog, select the relevant workflow from the Workflow to start dropdown list, then

click OK. Optionally, you may also enter a process note in the Process note field.

4. The Planned Page is initiated into the initial state of the selected Flatplanner workflow.

Note: Once a Planned Page has been initiated into a Flatplanner workflow, it may not be initiated into another
Flatplanner workflow.
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Start All Workflows Option in Publication Planner

As outlined in the steps in the previous two sections, multiple Planned Pages can be initiated into a workflow by
multi-selecting them in the Tree or Publication Planner. A third option also exists to submit Planned Pagesinto a
workflow at once: the Start All Workflows button in the Publication Planner.

| AutoPage Publication Planner H Pagination Rules || Page Inspector || Status H State Log H Tasls l

| Publication Section H Plan ] Publication Planner I Plan Motes H Financial Summary ]
Column View: |Default - View Options

Thumbnail * Name » |Page Mumber * Status > ID
Bl Party Masks 8, 9
B Napkins 10, 11
B Confetti 12,13
> .. Moisemakers 14, 15

] 1 »
[ Start All Workflows ] Update l

Clicking Start All Workflows is essentially the same thing as multi-selecting all Planned Pages in the Publication
Planner, right-clicking, and selecting Start Workflows. This button merely provides the convenience of a one-
click operation to achieve the same outcome.

Starting the Workflow Automatically
If the Flatplanner workflow is set to auto-initiate, new spreads will automatically appear in the initial state in the
Publication Planner.

In order to allow Planned Pages to initiate automatically in the workflow, follow these steps, which are the same as
for any standard STEP workflow:

1. In System Setup, navigate to the relevant Flatplanner workflow.

2. Onthe STEP Workflow Editor tab, check the Initiate automatically box.

3. New Planned Pages will automatically initiate into this workflow when created.

Note: Though STEP systems of version 8.0 and above allow the existence of more than one Flatplanner
workflow, only one Flatplanner workflow at a time should ever be set to auto-initiate. Allowing Planned Pages in
more than one workflow at once can cause conflicts if more than one user is working on the same page at the
same time, as STEP provides no version control to prevent multiple users from saving over each other's work.

Stopping the Workflow

Planned Pages may be manually removed from workflows in the same two locations where they can be started
manually: in the Publication Planner and in the Tree.

Method 1 - Publication Planner

To remove a Planned Page from a Flatplanner workflow from the Publication Planner, follow these steps:
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1. Inthe Tree, expand the Publication hierarchy, and then select the relevant Publication or Section.

2. Onthe Publication Planner tab, click the plus + sign next to the relevant Section to view the Planned Pages
within the Section.

3. Right click the relevant spread(s) and click Stop Workflows.

I Publication Section H Plan ]I Flan Motes H Financial
=~

Column View: .Default E
Thumbnail * Name * |Page Number * |Status * |ID * e
o Add Section In v

> ! Napkins Create new Section from existing... Sy

Add Pages Before Selected Page
Add Pages After Selected Page/Section

Autonumber Pages St
N/

w | W

Set page template
Remove Pages

View Plan

Assign Pages
Start Workflows
| Stop Workflows |
Return task to default group assignment

4. The Stop Workflows dialog appears. Click Yes.
5. The spread is now removed from the workflow.
Method 2 - Tree

To manually remove a Planned Page from a Flatplanner workflow from the Tree, follow these steps:

1. Navigate to the Planned Page(s) that you would like to remove from the workflow.
2. Right-click and select Remove from STEP Workflow.

3. Inthe Remove from STEP Workflow dialog, select the workflow that the spread is in, then click OK.
(Typically, spreads are only in one workflow.) Optionally, you may also add a Process Note.

E] Remove from STEP Workflow @

| (@) Fiatplanner Workfiow [startedi ‘

Process Note

[ OK H Cancel ]

4. The spread is now removed from the workflow.
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Publication Milestones
The Component Model Publishing - Milestone Settings enables monitoring of Flatplan workflow progress in
the Publication Planner via the Next Milestone Date/Next Milestone Name and Traffic Light Name columns.

The model allows you to:

« Select the object types where milestone dates can be entered—normally publication but can also be
publication section and publication group

« Select the object types where traffic lights can be defined—normally publication group

« Select the attribute that is used to hold the date when the workflow starts and up to 20 additional attributes to
hold the subsequent milestone dates

« Up to five traffic light colors can be defined—each of which requires a numeric attribute to store the
'percentage of working time remaining' and a second attribute to store the traffic light color

Component Model 'Publishing - Milestone Settings' Example

Milestone date and period / color configuration in Publication with Milestones component model

Name Example Value Validation Type

Publication Types defining milestone dates | Publication

Publication Types defining traffic lights Publication Group

Workflow Start Start Date ISO Date and Time

Milestone Date #01 Attribute Plan Page ISO Date and Time

Milestone Date #02 Attribute Plan Approved ISO Date and Time

Milestone Date #03 Attribute DTP Page Approved ISO Date and Time

Period #01 Normal Period Number

Period #01 Colour Normal Colour Regular Expression: [0-9a-f|{6}
Period #02 Warning Period Number

Period #02 Colour Warning Colour Regular Expression: [0-9a-f{6}
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Milestone date and period / color configuration in Publication with Milestones component model

Name Example Value Validation Type
Period #03 Late Period Number
Period #03 Colour Late Colour Regular Expression: [0-9a-f]{6}

The other configuration option that effects the milestones is the definition of the working week. Unless modified the
default setting is Monday to Friday from 09:00 to 17:00. Please contact Stibo if you need another definition of a
working week. When entering the milestone dates for a publication it is advisable that they are set to be during

working time.

Milestone Configuration Example on Publication Level

The attributes that are configured in the Component Model 'Publishing - Milestone Settings' must have values on
publication group, publication, or section level. The example below shows how the attributes might be configured
for a particular publication.

Attribute values at a publication

Attribute Example value Description

Start Date 2013-08-20 09:00:00 | Tuesday

Plan Page 2013-09-02 09:00:00 | Monday

Plan Approved 2013-09-10 09:00:00 | Tuesday

DTP Page Approved | 2013-09-20 09:00:00 | Friday

Normal Period 100 If the remaining working time is 100% then...
Normal Colour 'green’ ... the traffic light is green

Warning Period 40 If the remaining working time is 40% then...
Warning Colour ‘amber’ ... the traffic light is amber

© Stibo Systems - Confidential

152



StiboSystems

Attribute values at a publication

Attribute Example value Description
Late Period 0 If the remaining working time is 0% then...
Late Colour red’ ... the trafficlight is red

The milestone and traffic light information shown in the Publication Planner for a given page is calculated in the
following way:

« The workflow variable MILESTONE contains the Attribute ID of the next milestone date applicable to that
flatplan workflow. This variable is set by the business rules attached to the states within the workflow.

« The name of this attribute is displayed in the Next Milestone Name column of the Publication Planner

« The Next Milestone date is the value of the attribute obtained from the first publication/publication group
above the Flatplan with a value.

« The duration of the current task is then calculated as the amount of working time between the next milestone
date and the milestone prior to that date.

« The amount of remaining working time is then calculated as the difference between the next milestone date
and the current date and time.

« The percentage of remaining time is the amount of remaining working time as a percentage of the duration of
the current task. This can be greater than 100% and can also be negative if the next milestone date is in the
past.

« Thetraffic light is selected based on the percentage of remaining working time. From the above example:
percentages of 0% or less will show as red, 40% to 1% as amber, and everything else as green.

« The Traffic Light Name is the name of the attribute defining the traffic light color.
Monitoring of Flatplan workflow progress in the Publication Planner Example

Assuming that a publication has been created with the example dates and colors shown in the table above, and
that the current time is Friday 2013-09-06 09:00:00, then this is how the traffic light colors would be calculated.

Flatplan page-workflow and traffic light status with current date/time 2013-09-06 09:00:00

Page Workflow Colour Explanation
MILESTONE
1 Plan page red’ The next milestone date is (Plan Page) 2013-09-02
09:00:00

© Stibo Systems - Confidential 153



StiboSystems

Flatplan page-workflow and traffic light status with current date/time 2013-09-06 09:00:00

Page Workflow Colour Explanation
MILESTONE

The previous milestone date is (Start Date) 2013-08-20
09:00:00

The duration of the current task is therefore 8 working days

The current date/time exceeds (Plan Page) 2013-09-02

09:00:00 by 6 working days.
-6 as a percentage of 8 is -78% and so the corresponding
color is 'red'
2-3 DTP Page 'green’ The next milestone date is (DTP Page Approved) 2013-09-
approved 2009:00:00

The previous milestone date is (Plan Approved) 2013-09-10
09:00:00

The duration of the current task is therefore 8 working days

There are 10 working days from the current date/time until
the next milestone date

10 as a percentage of 8 is 125% and so the corresponding
coloris'green’

4-5 Plan Approved | 'amber’ The next milestone date is (Plan Approved) 2013-09-10
09:00:00

The previous milestone date is (Plan Page) 2013-09-02
09:00:00

The duration of the current task is therefore 6 working days

There are 2 working days from the current date/time until
the next milestone date

2 as a percentage of 6 is 33% and so the corresponding
color is 'amber’
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